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HOW TO CONTACT TELEDYNE RD INSTRUMENTS 

If you have technical issues or questions involving a specific application or deployment with your instru-
ment, contact our Field Service group:  

Teledyne RD Instruments  Teledyne RD Instruments Europe 

14020 Stowe Drive 
Poway, California 92064 

 2A Les Nertieres 
5 Avenue Hector Pintus 
06610 La Gaude, France 

Phone +1 (858) 842-2600  Phone +33(0) 492-110-930 

Sales – rdisales@teledyne.com  Sales – rdie@teledyne.com 

Field Service – rdifs@teledyne.com  Field Service – rdiefs@teledyne.com 

Client Services Administration – rdicsadmin@teledyne.com 

Web: https://www.teledynemarine.com  
For all your customer service needs including our emergency 24/7 technical support, call +1 (858) 842-2700 

Self-Service Customer Portal 
Use our online customer portal at https://www.teledynemarine.com/support/RDI/technical-manuals to down-
load manuals or other Teledyne RDI documentation.  

Teledyne Marine Software Portal 
Teledyne RD Instruments Firmware, software, and Field Service Bulletins can be accessed only via our Teledyne 
Marine software portal.  
To register, please go to https://tm-portal.force.com/TMsoftwareportal to set up your customer support ac-
count. After your account is approved, you will receive an e-mail with a link to set up your log in credentials to 
access the portal (this can take up to 24 hours).  
Once you have secured an account, use the Teledyne Marine software portal to access this data with your 
unique username and password. 
If you have an urgent need, please call our Technical Support hotline at +1-858-842-2700.  

 

  

mailto:rdisales@teledyne.com
mailto:rdie@teledyne.com
mailto:rdifs@teledyne.com
mailto:rdiefs@teledyne.com
mailto:rdicsadmin@teledyne.com
https://www.teledynemarine.com/
https://www.teledynemarine.com/support/RDI/technical-manuals
https://tm-portal.force.com/TMsoftwareportal
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CONVENTIONS USED IN THIS MANUAL 

Conventions used in the VmDas User’s Guide have been established to help you learn how to use VmDas 
quickly and easily. 

Menu items are printed in bold: Collect Data. Items that need to be typed by the user or keys to press 
will be shown as <F1>. If a key combination were joined with a plus sign (<ALT+F>), press and hold the 
first key while pressing the second key. Words printed in italics include program names (TRDI Toolz) and 
file names (TestWH.rds). 

Code or sample files are printed using a fixed font. Here is an example: 
WorkHorse Broadband ADCP Version 16.XX 
TELEDYNE RD INSTRUMENTS (c) 1996-2002 
ALL RIGHTS RESERVED 
> 
 
 

There are four visual aids to help: Notes, Cautions, Recommended Settings, and References. 

 

This paragraph format indicates additional information that may help avoid problems or that 
should be considered in using the described features. 

 

 

This paragraph format warns the reader of hazardous procedures (for example, activities that 
may cause loss of data or damage to the Tasman). 

 

 
This paragraph format indicates additional information that may help set command 
parameters. 

 

 
This paragraph format tells the reader where they may find additional information. 
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CH A P T E R  1  –  VM DA S  OV E R V I E W 

 

Chapter 1 

VMDAS OVERVIEW 

 

 

In this chapter:  

• VmDas software features 

• System requirements 

• How to install the VmDas software 

• ADCP Setup and Installation Overview 

• File Naming Conventions 
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Software Features 
VmDas is a software package used to collect real-time ADCP heading, pitch, roll, and GPS data. VmDas 
can also play back data and re-process data that is collected with VmDas.  

VmDas collects raw-beam data, heading, pitch, and roll data from internal sensors or external sensors and 
transforms the data to earth-coordinates. The software also creates short term and long term averaged 
PD0 data files as well as saving the data on a backup share (drive).  

VmDas has the option to screen ADCP data, for example, for error velocities, correlation, or RSSI; use 
three beam solutions if a beam or bin should be marked bad in a profile, and bin mapping. More details 
about three beam solutions and bin mapping can be found in TRDI’s Broadband Primer. 

VmDas version 1.44 and older has a backup NMEA port. As an example, this means that VmDas can rec-
ord NMEA data from two GPS devices and one heading device or two heading devices and one GPS de-
vice. 

For the Ocean Surveyor product, the software can collect and display narrow-band, broadband and bot-
tom track (interleaved), as well as displaying a ship-track reference to bottom-track or GPS data.  

The default Command files will work for most conditions. There may be cases where the user needs to cre-
ate a special command file (see Command Files and ADCP Configuration). 

Abbreviations 
The following abbreviations are used in this manual.  

ADCP – Acoustic Doppler Current Profiler 
BB – Broadband 
BT – Bottom Track 
DVL – Navigator 
NB – Narrowband 
OS – Ocean Surveyor 
OO – Ocean Observer 
WH – Workhorse 
UN – Unknown 

Computer Requirements 
VmDas requires: 

• Windows 10® or Windows 11® laptop or desktop computer  

 VmDas does not run or caused it to crash on MS Windows Server.  

 

• Minimum of one serial port; number of ports is dependent on the application (High Speed Serial 
Port recommended) 

• Minimum display resolution of 1024 x 600, 768 color  

• Mouse or anther pointing device 

• An Ethernet card if network I/O is desired 

 

VmDas can use up to six serial ports in some configurations. 
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Software Installation 
The VmDas software is available for download. 

1. Follow the instruction sheet on downloading TRDI software and manuals.  

2. Software is available on https://tm-portal.force.com/TMsoftwareportal.  

3. Unzip the file and double-click the VmDas vX.xx.xx Setup.exe file (where 
X.xx.xx is the version number) to install. 

4. Once the install is finished, use the desktop icon to start VmDas or click Start, 
All Programs, Teledyne RD Instruments, VmDas and then click on the VmDas icon. 

 

ADCP Setup and Installation Overview 
In order to use VmDas, your ADCP must be one of the following. 

• Ocean Surveyor/Observer ADCP  

• BroadBand ADCP  

• WorkHorse ADCP with the Bottom Track upgrade installed 

• Workhorse 2 ADCP  

 

The Bottom Track upgrade is available for WorkHorse Monitor and Sentinel ADCPs.  

 

Take a moment to familiarize yourself with the requirements for a Vessel Mounted deployment. See the 
ADCP Technical Manual for detailed information on how to install and verify the installation for the 
ADCP.  

 

This guide assumes you will be using a Vessel Mounted Ocean Surveyor ADCP and that the 
system has been installed and all Sea Acceptance Testing has been completed. 

 

https://tm-portal.force.com/TMsoftwareportal
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Shipboard Installation Overview 
Proper installation is critical to the success of data quality. Read the ADCP Technical Manual Installation 
chapter for details on ADCP installation.  

 

The ADCP Transducer installation requires 
that the position of Beam 3 with respect to 
the bow (heading reference) be well known 
(less than 0.5 degrees).  
Note:  Look for a small notch on the trans-
ducer housing to identify Beam 3. 

 

 

The keys to a successful installation are: 
• Transducer Installation 
• Windows 
• Flow Noise 
• Air Bubbles 
• Transducer orientation & alignment 
• Heading data quality 
• Navigation data quality 

 

Transducer Alignment Overview 
The Sea Acceptance Testing confirms the ADCP is operational and able to perform to its specifications 
(see the ADCP’s Technical Manual). The performance of any ADCP relies greatly upon the installation into 
any platform. Therefore, the system must be tested at sea to understand the effects of the platform on the 
ADCP performance. At sea testing includes tests for Acoustic Interference, Transducer Alignment, Profil-
ing Range, and Profiling Reasonableness testing.  

The mounting alignment of the transducer to the relative position of the heading input from the vessel is 
critical in the velocity estimates made by the ADCP. Once the correction value is determined by following 
the transducer alignment test, it is entered via the Transforms tab (see Setup the Transform Tab).  

BEAM 3 MARK AT 0 DEGREES
TO SHIP CENTERLINE

BEAM 3 MARK ROTATED 45 DEGREES
FROM SHIP CENTERLINE

FORWARD FORWARD

AFTAFT

TRANSDUCER

SOUND 
ABSORPTION 

MATERIAL

TRANSDUCER CABLE

FILL and AIR VENT TUBE

WINDOW 25 to 76mm THICK
POLYCARBONATE SHEET
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Errors in the transducer alignment result in 
both directional and magnitude errors in 
the water profile velocity. 
Errors will be a percentage of the misalign-
ment. A one degree error in alignment re-
lates to ~2% error in velocity measurement. 
Errors are seen as unreasonable currents 
(because ship motion is being placed into 
the data) and currents that change direc-
tion and magnitude as the vessel changes 
directions. 

 

 

Detailed instructions for the transducer alignment are included in the ADCP’s Technical 
Manual. 

 

 

Figure 1. Transducer Alignment 
 

 

20 to 30 Minutes Per  Turn
 

 

20 to 30 Minutes Per  Turn
 

60 Minutes Per Leg 
Minimum Time
4.5 to 7 Hours

 

Minimum of 5 Legs 
 

Each of the vertical lines represents the point when the vessel changed directions.

Using the correct transducer 
alignment angle results in 
equal current magnitudes on 
each side of the reciprocal course.   

An incorrect transducer alignment 
was used, resulting in current 
magnitudes that  do not match in 
opposite directions.  Notice that the 
current magnitudes do not match 
at the turning point of each leg. 
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File Naming Conventions 
Data files produced by VmDas during data collect mode have the following filename format:  
DeployName000_YYYYMMDDTHHMMSS_000000.Ext, 
Where: 

DeployName is a user-entered name for the deployment (up to 64 characters), 

000 is the deployment number (changes with each stop/restart), 

YYYYMMDDTHHMMSS Is the date and time (if check box Use Date is selected on the Recording tab) 

000000 is the file sequence number, which is incremented when the specified maximum file 
size is reached, and 

Ext is the file extension, and reflects the type of data in the file 
 

Reprocessed files have a similar format: DeployName000_000_YYYYMMDDTHHMMSS_000000.Ext, 

Where: 

000 
Represents the reprocessing number, and gets incremented each time the same raw data is 
reprocessed. The other fields are the same as for the data collect mode format, and identify 
the raw data source that was reprocessed. 

File Extensions 
The file extensions have the following meaning:  

.ENR Raw ADCP data file (see your ADCP Technical Manual Commands and Output Data Format guide for the output data 
format). 

.LTA ADCP (plus Navigation Data (see Binary Navigation Data Format)) data that has been averaged using the long time 
period specified in the Options, Edit Data Options, Averaging tab. 

.STA ADCP (plus Navigation Data (see Binary Navigation Data Format)) data that has been averaged using the short time 
period specified in the Options, Edit Data Options, Averaging tab. 

.ENS ADCP data after having been screened for RSSI and correlation by VmDas. Also has Navigation Data (see Binary Navi-
gation Data Format) records merged into the ensembles from the .NMS file. 

.ENX ADCP single-ping data (plus Navigation Data (see Binary Navigation Data Format) after having been bin-mapped, 
transformed to Earth coordinates, and screened for error velocity, vertical velocity, and false targets. This data is 
ready for averaging. 

.N1R, .N2R, .N3R Raw NMEA data files (text files)  

.NMS Binary format NAV data file after having been screened and pre-averaged. 

.VMO The option settings used for collecting the data (text file). 

.VMP The option settings used for reprocessing the data (text file). 

.LOG ASCII file containing any errors found in NMEA, ASCII Ensemble Output, or ADCP communications. The *.LOG file is 
saved to the same path as set in the Recording tab.  

.ini Once the settings are made, they are saved to a Data Option file (*.ini) so they may be used for deployments. 
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Figure 2. Most Common Data Files 
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NOTES 
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CH A P T E R  2  -  TU T O R I A L S  

 
 

 

 

 

 

 

Chapter 2 

TUTORIALS 

 

 

In this chapter:  

• First Time Setup of VmDas 

• Collecting Data 

• Reprocessing Data 

• Playback Data 

• VmDas Displays 
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Tutorial - First Time Setup of VmDas 
Options control how VmDas processes data during collection and reprocessing. Some options are changed 
every deployment; others are seldom changed.  

In this section you will setup the Communications, ADCP Setup, Averaging, Transform, and Data 
Screening tabs. These tabs are typically a one-time setup. Once the settings are made, they are saved to a 
Data Option file (*.ini) so they may be used for deployments. 

 

Data Options can be edited only when Collect Data or Reprocess Data mode is selected on 
the File menu, and collection or reprocessing data is not in progress. 

 

 

Start VmDas.  
On the File menu, click Collect Data.  

 

 

On the Options menu, click Load.  
Select the C:\Users\yourname\Ap-
pData\Roaming\Teledyne RD Instru-
ments\VmDas\Default.ini file.  
Click Open. This will set VmDas to the fac-
tory default options. 

 

 

On the Options menu, click Edit Data Op-
tions to display a tabbed dialog box.  
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Setup Communications 
Click the Communications tab and set the communications settings for the ADCP and NMEA ports. Up 
to four serial ports may be enabled and configured for input, and three more serial ports for output.  

 

Figure 3. Communications Tab 
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ADCP Input 
ADCP input is required. VmDas logs the ADCP data to an *.enr file and then does several processing steps 
to it. Data is stored in several files as processing proceeds. Raw and processed data may be displayed. 

 

1. Click the ADCP Input radio button in the 
Select Item to Set box. When this is 
done, the controls in the Set Communi-
cation Parameters Here box apply to the 
ADCP Input port. 

 

 

2. In the Set Communication Parameters 
Here box, click the Enable Serial check 
box to enable the controls for configur-
ing the serial port. 
Set the serial port to match the ADCP se-
rial port wakeup settings. TRDI strongly 
recommends 9600, No Parity, 8, 1 for 
the ADCP Input port. 
Click Enable Network and select UDP. 
Enter the Port to enable Ethernet. 

 

 

3. When the settings are correct, click the 
Set button and verify that the settings 
are reflected in the top row of the Cur-
rent Settings section.  

 If you do not click the Set button, 
your setting will be lost when another Se-
lect Item to Set box is selected.  

 

 

3. When connecting to an ADCP via Ether-
net, a soft break (===) is used to wake up 
the ADCP, and it may take a number of tries 
to wake up the instrument.  

 While the ADCP is pinging, inter-
rupts are off and it will miss/lose the soft 
break characters. The ADCP must NOT go to 
sleep as hard breaks are not supported by 
Ethernet.  
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NMEA Data 
NMEA input is optional. All enabled NMEA input is logged to *.n1r, *n2r, and *.n3r files. VmDas can also 
use GGA, VTG, heading, and tilt data. 

 

VmDas can accept optional NMEA data on 
up to three serial ports.  
The NMEA standard requires the settings to 
be 4800, No Parity, 8, 1, however, some 
equipment can transmit faster.  

 

VmDas Outputs 

 

Ensemble Output Data 
As an option, Long Term Averaged ensem-
ble data can be output in the TRDI standard 
binary ensemble (PD0) output format. 
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Ensemble Output (ASCII) Data 
ASCII-out files contain a fixed format of 
text. You can then use these files in other 
programs (spreadsheets, databases, and 
word processors). 

 

 

Speed Log Output Data 
Speed log data output consists of the NMEA 
VBW and DBT messages, and is calculated 
from the short-term averaged data.  
Note:  Speed log data is not stored to a disk 
file. It is only sent to a serial port and/or an 
Ethernet port. 
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ADCP Setup Tab 
Click the ADCP Setup tab. Use this tab to set the ADCP commands.  

 

Figure 4. ADCP Setup Tab 
 

 

1. Select Use File in the ADCP Setup from 
File area.  

 

 

 
2. Set the Ensemble Time to the value 

shown in the table below.  
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Table 1: Ensemble Time 
Frequency (kHz) With Bottom Track (sec) Without Bottom Track (sec) 

38 4 2 

75 2 1 

150 1 1 

300 

Select Ping as Fast as possible 600 

1200 

 

 

 

3. Click the Browse button and use Table 2 
to choose a command file for your 
ADCP and load it into VmDas. Select the 
file and click Open. 

These text files (*.txt) were copied into 
the same directory as VmDas when you in-
stalled it from the CD sent with your sys-
tem.  
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Table 2: Example Data Option Files 

File Name Description 

OS38BBDEF  Default setup for an Ocean Surveyor (OS) 38kHz ADCP in the highest precision (broad bandwidth) but 
reduced range profiling mode. 

OS38NBDEF  Default setup for an Ocean Surveyor (OS) 38kHz ADCP in the longest range (narrow bandwidth) but re-
duced precision. 

OS38BB&NBDEF  Default setup for an Ocean Surveyor (OS) 38kHz ADCP in the highest precision (broad bandwidth) and 
the longest range (narrow bandwidth) but reduced precision. 

OS75BBDEF  Default setup for an Ocean Surveyor (OS) 75kHz ADCP in the highest precision (broad bandwidth) but 
reduced range profiling mode. 

OS75NBDEF  Default setup for an Ocean Surveyor (OS) 75kHz ADCP in the longest range (narrow bandwidth) but re-
duced precision. 

OS75BB&NBDEF  Default setup for an Ocean Surveyor (OS) 75kHz ADCP in the highest precision (broad bandwidth) and 
the longest range (narrow bandwidth) but reduced precision. 

OS150BBDEF  Default setup for an Ocean Surveyor (OS) 150kHz ADCP in the highest precision (broad bandwidth) but 
reduced range profiling mode. 

OS150NBDEF  Default setup for an Ocean Surveyor (OS) 150kHz ADCP in the longest range (narrow bandwidth) but re-
duced precision. 

OS150BB&NBDEF  Default setup for an Ocean Surveyor (OS) 150kHz ADCP in the highest precision (broad bandwidth) and 
the longest range (narrow bandwidth) but reduced precision. 

BB75DEF  Default setup for a BroadBand (BB) 75kHz ADCP to provide the most range with the optimal precision. 

BB150DEF  Default setup for a BroadBand (BB) 150kHz ADCP to provide the most range with the optimal precision. 

BB300DEF  Default setup for a BroadBand (BB) 300kHz ADCP to provide the most range with the optimal precision. 

WH300DEF  Default setup for a WorkHorse (WH) 300kHz ADCP to provide the most range with the optimal precision. 

WH600DEF  Default setup for a WorkHorse (WH) 600kHz ADCP to provide the most range with the optimal precision. 

WH1200DEF  Default setup for a WorkHorse (WH) 1200kHz ADCP to provide the most range with the optimal preci-
sion. 

WH2_1200DEF Default setup for a WorkHorse 2 (WH2) 1200kHz with 600kHz 5th Beam ADCP to provide low resolution, 
long range profile (broadband processing). 

OO38BBDEF  Default setup for an Ocean Observer (OO) 38kHz ADCP in the highest precision (broad bandwidth) but 
reduced range profiling mode. 

OO38NBDEF  Default setup for an Ocean Observer (OO) 38kHz ADCP in the longest range (narrow bandwidth) but re-
duced precision. 

OO38BB&NBDEF  Default setup for an Ocean Observer (OO) 38kHz ADCP in the highest precision (broad bandwidth) and 
the longest range (narrow bandwidth) but reduced precision. 

V20-RTDEF Default setup for a V20 (1000 kHz) Sentinel V Real-Time ADCP to provide low resolution, long range pro-
file (broadband processing). 

V50-RTDEF Default setup for a V50 (500 kHz) Sentinel V Real-Time ADCP to provide low resolution, long range pro-
file (broadband processing). 

V100-RTDEF Default setup for a V100 (300 kHz) Sentinel V Real-Time ADCP to provide low resolution, long range pro-
file (broadband processing). 
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Setup the NAV Tab 
Use the NAV tab to enable the ports and decide whether or not to save GGA or VTG data in the NAV field 
of the ENS, ENX, STA, and LTA files. Choose which enabled ports to read it from on the drop down list. 
Only enabled ports appear in the drop down lists.  

You can enable a backup source for GGA or VTG. If you choose a backup source, the primary source will 
be put into the NAV field. If primary data becomes invalid, backup data will be saved in the NAV field in-
stead.  

 

Figure 5. NAV Tab 
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Select the Enable box on the NAV tab and 
select the NMEA Port from the drop down 
list. 

 The NMEA ports must be first setup on 
the Communications tab (see NMEA Data). 

 

VmDas uses the PC time as its time reference. GGA data contains a time value. VmDas calculates the off-
set between the PC and GGA clocks. This is saved and used to synchronize data.  

 

GGA and VTG data will be saved in the *.N1R, *.N2R, or *.N3R files even if not enabled on the 
NAV tab. Data needed to calculate the clock offsets will also be saved. 

 

 

The PC clock offset is calculated independently for primary and backup data. If backup GGA 
data goes into the NAV field, the backup offset goes with it. 

 

 

Do the same for the VTG source if needed. 
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Setup the Transform Tab 
VmDas reads single ping beam coordinate data from the ADCP. VmDas transforms the data to earth coor-
dinates and averages it. How the transformation is done depends on details of the geometry of the ADCP, 
sensors, and the platform they are mounted on. Use this screen to select the Heading Source, Tilt 
Source, Heading Sensor Magnetic/Electrical Corrections, and ADCP Alignment Correction.  

 

Figure 6. Transform Tab 

 

You can only enable a backup source if the primary source is an NMEA message. 
A fixed heading or tilt is never bad. The ADCP never tells you that the variable leader's 
heading, pitch, or roll is bad. Instead, it quietly replaces the bad data with a fixed value set by 
EH, EP, or ER commands. This is done whether the bad data comes from the ADCP's internal 
sensors or external gyros attached to the ADCP.  
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1. VmDas requires heading data and option-
ally, pitch and roll data. The data can 
come from the ADCP’s internal compass 
and tilt sensors, gyros connected to the 
ADCP’s electronics chassis, NMEA data 
from a serial port, or fixed values en-
tered by the user.  

For information on how the to create 
custom decoder files for NMEA heading, 
pitch, and roll (HPR) data, See the VmDas 
User's Guide – Using the Custom NMEA 
Feature. 

 

 

2. It is possible to use one source for head-
ing and a second source for pitch and 
roll. 

 

 

3. Sometimes the heading source reports 
magnetic data, and some sensors are 
not aligned to the ADCP.  
For these situations, enter the 
corrections.  

 

 

4. Sometimes the tilt sensors are not 
aligned to the ADCP’s axes. Enter the 
corrections for Pitch and Roll. 
Check the Override command file EA 
check box and enter the EA correction. 
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Setup the Averaging Tab 
The Averaging property page allows you to set the Ensemble Averaging interval and Reference Layer Av-
eraging properties.  

• The Averaging Method controls how many pings are averaged together in the STA (Short 
Term Average) and LTA files (Long Term Average).  

• The Profile Ping Normalization Reference Layer can be used when no Bottom Track or 
GPS is available. 

 

Figure 7. Averaging Tab 
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1. The First Time Interval is what we refer 
to as the Short Term Average (which will 
become file name with a *.STA exten-
sion).  
The Second Time Interval is what we re-
fer to as the Long Term Average (which 
will become file name with a *.LTA ex-
tension).  
You can set these to any times you like 
and they may even be the same value.  

 

 

2. When using a Reference Layer, use bins 
in the upper part of the profile and bins 
that have a high percent good (more 
than 85%). If you select a bad bin range, 
the averages will be wrong and data will 
be bad. 
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Setup the Data Screening Tab 
Click the check boxes for the data screening options you wish to enable. When a box is checked, its associ-
ated edit box becomes enabled, and you may enter a threshold value for screening the data. The screened 
single-ping data is saved with an *.ENS extension. 

 

Figure 8. Data Screening Tab 

 

You are able to screen data based on the 
items in this menu and the thresholds you 
decide during real-time or when repro-
cessing. This screening will affect what is 
displayed on the screen and what data is 
recorded to the *.STA and *.LTA files. The 
original raw data will be unaffected by what 
is setup here.  
1. For real-time data collection, we recom-

mend you only enable Mark Bad Below 
Bottom. You can reprocess data later 
and change the settings in this screen to 
see what the effect it has on the data. 
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Save Changes to the Data Option File 

 

Click OK on any tab to save the changes 
made to the Program Options tabs. 
Changes are not saved until the OK button 
is clicked. 
Clicking OK causes VmDas to do a con-
sistency check and save the new settings as 
the current data options. 

 

 

If an error is found, a message describing 
the error will pop up and no changes will be 
saved. The user can either correct the prob-
lem, or cancel editing and lose all changes 
made. 

Saving and Loading Data Option Files 
VmDas saves the current options to the C:\Users\yourname\AppData\Roaming\Teledyne RD Instru-
ments\VmDas\VmDasAutoConfig.ini file whenever you close data collection, reprocessing, or playback 
modes (File, Close or the gray  button) or exit VmDas (File, Exit or the red  button). These most 
recently saved options are used whenever VmDas is started. You can save the current options to your own 
*.ini file and load the file to use them as the current options. The current data options are the starting 
point when you edit options.  

  

 

Saving Data Option Files 
On the Options menu, click Save As. Enter a 
File Name and click Save. 
The options may be saved to a file for later 
retrieval. You may wish to save several sets 
of options, to be used as starting points for 
different deployments. Option files that are 
created this way may have any name you 
choose. 

 

 

Loading Data Option Files 
On the Options menu, click Load.  
Select the *.ini file and click Open.  
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Tutorial - Collecting Data 

 

Start VmDas.  
On the File menu, click Collect Data.  

 

 

On the Options menu, click Load.  
Select the *.ini file with the options you 
want to use. Click Open. 

 

 

This step is only for systems where the gyro is directly 
wired to the electronics chassis using a synchro or stepper. 

Gyro initialization must be done at dockside 
prior to the deployment and set at the front 
panel of the electronics chassis or entered 
in the Transformation Tab (EV command). 
The Offset Control buttons on the electron-
ics chassis are Up, Set, and Down, as de-
picted by the upward arrow, the square 
box, and the downward arrow respectively.  
For example, to set a heading offset for a 
multi-rate gyro, push the up or down but-
ton and set button simultaneously, using 
two small aids such as a pencil. When the 
desired offset is obtained, release the but-
tons. To prevent accidental re-adjustment, 
the buttons are recessed. 
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Set Recording Options 
The Recording property page allows you to set the deployment name and path to where the data files are 
recorded. The Recording name is typically the only change that will occur each deployment.  

 

Click Options, Edit Data Options.  
Click the Recording tab.  
Enter a name in the Name box that identi-
fies your deployment (maximum 64 charac-
ters). This name will be used as part of the 
filename for each file that is part of this de-
ployment.  
VmDas will increment the Number each 
time collection is started. The Number will 
be used as part of the file name. For a new 
deployment, set it back to 1.  
Check the Use Date box to add the date and 
time to the file name. 

It is recommended to not set the Maxi-
mum File Size greater than 10MB as larger 
files will slow data processing considerably.  

 

 

Enter the Primary Path where the raw, in-
termediate, and processed data files are to 
be stored.  
Clicking the Browse button to the right of 
the Primary Path edit box will allow you to 
browse your computer to select a folder to 
record to.  
You will be presented with a Select Folder 
dialog box, which will have the default path 
of C:\Program Files (x86)\RD Instru-
ments\VmDas selected.  
Select the primary path (note the folder 
must already exist) and click OK.  
Click the Dual Output Directory box and en-
ter the Backup Path to backup data. The 
Backup Path is an optional backup to pre-
serve data if a hard disk crashes. It is only 
useful if your PC has two disks.  
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Click OK to exit the Edit Data Options 
screens.  
On the Options menu, click Save As to save 
the *.ini file (see Save Changes to the Data 
Option File).  

 

 

On the Control menu, click Go to begin col-
lecting data.  
The ADCP Communication window will 
open and show the commands from the 
command file you selected being sent to 
the ADCP and the ADCP’s response.  
Once all of the commands have been cap-
tured to the *.LOG file, the window will 
close automatically and data collection will 
begin.  
The *.LOG file is saved to the same path as 
set in the Recording tab.  

 

 

You can review the ADCP Communication window by selecting View, ADCP Communication. 
You should carefully check for error messages from the ADCP when starting a new 
configuration for the first time. 

 

 

Use the Chart menu to view the data as it is 
collected (see VmDas Displays).  

 

 

Use the Control menu or toolbar (see 
Toolbars) to stop data collection when fin-
ished. 
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Tutorial - Reprocessing Data 
When data is collected, the raw data is logged in *.ENR and *.N*R files. Then it is processed and stored in 
a variety of files (see File Naming Conventions). The options selected before data collection begins controls 
how the processing is done. The *.ENR and *.N*R files are not changed during reprocessing.  

Reprocessing data starts over with the raw *.ENR and *.N*R files. It allows you to choose new options and 
repeat processing steps. You can then playback the reprocessed data to display it. This is useful if you 
want to fix a mistake or just change parameters. For example, suppose you collected data with the wrong 
EA value. You can correct the value on the Transform tab and reprocess the data file. Maybe you want 
new screening parameters or averaging intervals. The following example shows the overall process with-
out selecting specific options to change. 

 

Start VmDas.  
On the File menu, click Reprocess Data. 

 

 

Browse and locate the *.vmo file for the 
data you wish to reprocess.  
For this example, select the 
SAMPLE002_000000.VMO file.  
Click Open. 

 

 

Click Options, Edit Data Options. 
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Click the Recording tab. 
Verify the Name of the data set is the one 
you wish to reprocess. 
Verify the Number of the data set is the one 
you wish to reprocess. 
Choose a new path if desired. The output 
files will be similar to, but different from 
the input files. 

 

 

Click the NAV tab. You can decide whether 
or not to save GGA or VTG data in the NAV 
field of the ENS, ENX, STA, and LTA files.  
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Click the Transforms tab. 
You can change the heading or tilt sources 
here, or change the heading or tilt correc-
tions.  
Leave the settings as they are to keep the 
values from data collection. 

 

 

Click the Averaging tab. 
You can change averaging intervals here.  
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Click the Data Screening tab. 
You can choose new screening options 
here. 

 

 

Click OK to exit the Edit Data Options 
screen. 

 

 

Save the Data Option file by clicking Op-
tions, Save As. 
Enter a file name and click Save for the *.ini 
file that you have just created. 
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To start data reprocessing, on the Control 
menu, click Go.  
You should see the Ensemble number in-
crease on the Processing Bar during repro-
cessing.  
If the Processing Bar is not visible, Click 
View, Processing Bar.  
When reprocessing is done, you will see the 
message “Done!” next to the toolbar. 

 

 

No data is displayed during Reprocessing. Use the Playback mode to view the data after 
Reprocessing. 
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Tutorial - Playback Data 
Playback is used for displaying data that has already been collected or reprocessed. See VmDas Displays for 
descriptions of what can be displayed.  

 

Start VmDas.  
On the File menu, click Playback Data. A list 
of recently opened files is at the bottom of 
the menu.  

 

 

Browse and locate the data file for the data 
you wish to view. Click Open. 
VmDas will automatically search for *.enr, 
*.enx, *.sta, and *.lta files. 
In order to view files that use other naming 
conventions, the user can either type the 
file name directly into the File name field of 
the Open File dialog box, or click in the Files 
of type box to select the All files (*.*) filter 
from the drop-down list.  

 

 

On the Playback Tool Bar, click Play.  
Use the Window Toolbar (Toolbars) to dis-
play the desired graphs and then click the 
Resize button to arrange the graphs. 

 Resize button 
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Tutorial – Configuring VmDas Displays 
VmDas can be configured to look as you prefer.  

 

Figure 9. VmDas Display Showing Distance Traveled 

Velocity Plot 

 

The Velocity plot shows the Velocity in 
mm/s and the direction in degrees. The 
magnitude scale is along the top, in mm/s, 
and the direction scale is along the bottom, 
in degrees. Use the Graph Toolbar to 
change the scale of the plot. If the graph 
toolbar is not visible, click View, Graph Bar.  
The velocity units can be set to ms, mm/s, 
f/s, or knots. The depth units can be me-
ters, centimeters, or feet. To change them, 
click Options, Edit Display Options. Note 
that changing the display options only 
changes how data is displayed, not what is 
saved in the data files.  
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Data Quality Plot 

 

The Data Quality plot shows the Amplitude, 
Correlation, and Percent Good values.  
The scale along the top is for the amplitude 
and correlation (in counts). Amplitude and 
correlation are an average of all four 
beams. The depth units can be meters, cen-
timeters, or feet. To change them, click Op-
tions, Edit Display Options. Note that 
changing the display options only changes 
how data is displayed, not what is saved in 
the data files.  
The scale along the bottom is for percent 
good (in percent). The percent good plot is 
produced by summing PctGd1 and PctGd4 
for each depth cell (see Profile Data). 

 

Combination Plots 

 

If the file contains both BroadBand and Nar-
rowband data, selecting C on the Window 
toolbar will show a Combination of Broad-
Band and Narrowband data. 
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Ship Track Plot 

 

The Ship Track plot shows the path of the 
vessel and up to three current sticks to dis-
play currents at different depths at each 
plotted ship position. VmDas has two ship 
track plots. They display the same ship 
track, but may be configured differently; 
For example, they may have different posi-
tion sources or use different bins for cur-
rent sticks.  
Ship track configuration is set by clicking 
Options, Edit Display Options. Most config-
urations use the Ship Track tab, though cur-
rent stick velocity units are set in the Refer-
ence tab.  
Holding the cursor over a ship track position 
causes a tool tip to be displayed. It shows 
the position and current stick data for the 
point. 

 

 

In Data Collection mode, the ship track plots are not available in the raw data view. 

 

Profile Data 

 

The Profile Data display shows a tabular 
view of the ADCP’s Profile Data, and in-
cludes the following fields. 

 

Bin - The ADCP depth cell number that the row of tabular data applies to. This field is repeated at the far 
right of the table for easy reference when looking at data in the rightmost columns of the table when the 
entire table is not in view. 
Depth - The depth of the center of the depth cell. If a transducer depth has not been entered, this is the 
range to the depth cell from the ADCP transducer. If a transducer depth has been entered, this is the 
range to the depth cell from the water surface, measured in the selected depth units. 
Bm1 through Bm4 - When viewing raw data, these are the individual beam velocities at the depth cell, 
measured in the selected velocity units. Bm1 through Bm4 are replaced by East, North, Up, and Err when 
viewing averaged data, and then refer to the Earth-referenced velocity components at the depth cell, and 
are also shown in the selected velocity units. 
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Amp1 through Amp4 - The echo intensities (amplitudes) for each beam at the depth cell, measured in 
counts. The Amplitude plot in the data quality profile graph is produced from the average of Amp1 
through Amp4 for each depth cell. 
Cor1 through Cor4 - The correlation magnitude values for each beam at the depth cell, measured in counts. 
The Correlation plot in the data quality profile graph is produced from the average of Cor1 through Cor4 
for each depth cell. 
PctGd1 through PctGd4 - The percent good data at the depth cell, measured in percent. In the raw data 
view, PctGd1 through PctGd4 refer to individual beam percentages, however percent good data is typically 
not by the ADCP output for single-ping data. These fields are more useful when looking at the averaged 
data views, where PctGd1 through PctGd4 have the following meaning: 

• PctGd1 - is the percentage of good 3-beam measurements in the averaging period for the depth 
cell. 

• PctGd2 - is the percentage of measurements rejected due to high error velocity in the averaging 
period for the depth cell. 

• PctGd3 - is the percentage of measurements that were rejected due to having fewer than three 
beams good for the averaging period in the depth cell. 

• PctGd4 - is the percentage of good 4-beam measurements in the averaging period for the depth 
cell. 

 

The percent good plot in the data quality profile graph is produced by summing PctGd1 and 
PctGd4 for each depth cell. 

 

Other Displays 

 

The leader data shows a text box of the 
ADCP’s leader data. 

 

 

The Bottom Track Data shows a text box of 
the ADCP’s Bottom Track Data and Distance 
Traveled. 

 

 

The Water Track Data shows a text box of 
the ADCP’s Water Track Data. 

 

 

The Navigation Data shows a text box of the 
position and velocity data from a NMEA 
navigation device. 

 

 

The System Configuration Data shows a text 
box of the ADCP’s System Configuration 
Data. 
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Toolbars 
The toolbars control VmDas processing and displays. There are three tool bars; Window Tool Bar, Graph 
Tool Bar, and Playback/Processing Tool Bar. 

The Window and Playback/Processing toolbars provide shortcuts. Each button on these toolbars does the 
same thing as a menu item. There is no matching menu for the Graph toolbar.  

Holding the cursor over a button displays a tool tip with a brief explanation of the button. The toolbars are 
normally docked together at the top of the main window. If more screen space is desired, they can be hid-
den with the View menu. The View menu also restores hidden toolbars.  

Toolbars can also be moved around or undocked. To do so, move the cursor over a toolbar between the 
buttons, left click, and drag. Release the mouse button to drop the toolbar. 

Window Toolbar 

Collect Mode 

 
 
 
 

Playback Mode 

 

The Window toolbar turns display windows 
on or off. Each button does the same thing 
as a Chart menu item.  
In collect mode the Window toolbar looks 
like shown here. 
In Playback mode, the Raw Data, Short-
Term, and Long-Term averaged data but-
tons (three buttons on the left) will not be 
displayed.  
If the data contains both BroadBand and 
Narrowband data, three additional buttons 
are displayed on the left. Selecting C will 
show a Combination of BroadBand and Nar-
rowband data. 

 

Graph Toolbar 

 

The Graph toolbar controls the appearance 
of the graphs.  
The radio buttons to the left select which 
graph is affected by the controls on the 
right.  
The arrow buttons move the plotted data in 
the indicated directions, while the zoom 
buttons change the scale ranges. The two 
zoom buttons with the red, green, and blue 
lines re-scale the current sticks on the Ship 
Track plots. 
Click the Keep on Screen box to keep the 
leading edge of the Ship Track plot always 
on the graph.  
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There is no menu to do the Graph toolbar commands. Even if you hide the other two toolbars 
to make more space, you might want to keep this toolbar visible until the graphs are set up 
the way you like them. 

 

Playback / Processing Tool Bar 
This toolbar is available in all three modes. It controls how VmDas reads and/or processes ensembles. 

 

Data Collect Mode 

In Collect mode, the toolbar looks like this.  
The left button starts data collection.  
The right button stops data collection. 

 

 

Data Playback Mode 
In Playback mode, the toolbar looks like 
this. 
The buttons work like tape recorder con-
trols. From left to right, they: 
• Rewind to the first ensemble in the file 
• Step back to the previous ensemble, 
• Step to the next ensemble 
• Start playing ensembles 
• Stop playing ensembles 
The slider controls playback speed. If you 
hold down the shift key as you click the 
Step Next or Step Previous buttons, VmDas 
steps 100 ensembles. 

 

 

Data Reprocess Mode 
In Reprocess mode, the toolbar looks like 
this. 
The left button brings up the options dialog 
so that options can be edited.  
The middle button starts reprocessing.  
The right button aborts reprocessing. This 
button in not used in normal reprocessing. 
Reprocessing normally stops when all data 
reprocessing has been done. 
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Font Size 

 

Stick Ship Track Plots have a tool bar that 
can be turned on by right clicking on the 
widow and selecting Show Toolbar. 
Right click on the widow and select Proper-
ties to change the size of the fonts. Choose 
the font for labels and data.  

 

 

You can change the size of the fonts in tab-
ular plots by right clicking on the widow and 
selecting Properties.  
Use the arrows (circled) to locate the Font 
tab and choose the font for labels and data.  

 Do not change any other setting as 
this may cause unpredictable results. Use 
the Graph Toolbar (see Toolbars) to adjust 
the plot axis.  

 

Status Bar 

 
The Status Bar tells you what COM ports are 
open and their status. 
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Display Units and Reference 

 

Reference Tab 
On the Options menu, click Edit Display Op-
tions.  
Click the Reference tab to select the display 
units, or the velocity reference to use for 
profiles.  
The Reference Velocity is used to remove 
the ship’s velocity from the water current 
profile. 
 
 

 

 

Ship Track Tab 
Click the Ship Track tab to select the ship 
position source and the profile bins to use 
for the current stick plots. 
Changes made to the Ship Track tab may 
require that the ship track be re-plotted. 
VmDas will issue a warning before 
accepting these changes. If the ship track 
must be re-plotted, the ship track is erased. 
Plotting continues from the current 
position.  
When collecting data, this means it is a 
good idea to settle on desired configura-
tions early. Once erased from the display, 
the Ship Track cannot be redisplayed until 
the deployment files are played back. 
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Tutorial - Viewing Data with WinADCP 
VmDas can automatically start the WinADCP application when data collection is started. When in moni-
tor mode, WinADCP will periodically refresh its displays from the data recorded by VmDas, and will allow 
you to view time series and contour graphs of the data. From the WinADCP application menu, you can 
exit the monitor mode to change the WinADCP setup, and then reenter the monitor mode to continue the 
data updates. The WinADCP application must be installed on the computer for this option to work. 

 

On the User Exits tab, click the Launch 
WinADCP checkbox to have VmDas 
automatically start the WinADCP 
application in monitor mode when data 
collection is started.  
Select which type of data to view with 
WinADCP using the Data File to Open box.  
Enter the number of seconds that WinADCP 
should wait between screen refreshes in 
the Refresh Interval (sec) box. 

 

 

Once data collection has started, you can 
use the WinADCP application menu to open 
a different file type if desired. Just remem-
ber to exit the monitor mode in order to 
make the change, then reenter monitor 
mode to continue the automatic data re-
freshing. 

 

 

When you press Stop, VmDas leaves WinADCP open so that your data screen does not 
disappear. A consequence of that is if you have WinADCP enabled as a User Exit, and click Go, 
Stop, Go in VmDas, it will cause a second instance of WinADCP to run. 

 

  



 

P/N 95A-6015-00 (January 2024) VmDas Software User’s Guide 

 

Page 44 EAR99 Technology Subject to Restrictions Contained on the Cover Page.  
 

NOTES 
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CH A P T E R  3  –  C R E A T I N G  A  D A T A  OP T I O N  F I L E  

 
 

 

 

 

 

 

 

 

 

 

 

 

Chapter 3 

CREATING A DATA OPTION FILE 

 

 

In this chapter:  

• Setting up Data Options 

• Setting up Display Options 

• Data Options Screens 
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In the following, you will be creating a Data Option file that will be used to program both the ADCP and 
VmDas software processing.  

The VmDas, WinADCP, and RDI Tools software should be installed on your computer as outlined in Soft-
ware Installation. Connect the ADCP to a computer as shown in the ADCP Technical Manual, and apply 
power to the ADCP.  

1. Start VmDas. Click File, Collect Data. 

2. Click Options, Load. Select the C:\Users\yourname\AppData\Roaming\Teledyne RD Instru-
ments\VmDas\Default.ini file. Select Open. 

3. Click Options, Edit Data Options. See Data Options Screens for details on each tab. Once you 
have set all the parameters, click OK to exit the Edit User Options screens. When OK is clicked, 
VmDas checks the new options for consistency. For example, it is not allowed to use the same se-
rial port twice on the Communications tab. If VmDas finds an error, it will display an error mes-
sage box and refuse to close the Edit Data Options dialog box. You may either correct the er-
ror(s), or use Cancel to abandon all changes to the options. 

4. Save the Data Option file by clicking Options, Save As. Enter a file name for the *.ini file that you 
have just created. This *.ini file will save the setup in all of the tabs including the path to the com-
mand text file. You can use this same method in case you wish to create several different setup files 
for the same machine. As an example, you could create a command text file that has a 6-meter bin 
size. You might save this to a text file with the name BB150BIN6M.txt and call the *.ini file 
6METER.ini. You could then create another command file and *.ini file with a 16-meter bin size 
with the same concept. Then when you want to actually use the proper command file you just have 
to select the *.ini file you intend to use.  

Setting up Data Options 
When data collection or data reprocessing is started, the current data options tell VmDas how to collect 
and process the data. 

• Data options are not used for playing back data. Editing them is not allowed in playback mode. 

• VmDas stores the current data options. They persist until changed, even if VmDas is closed and 
restarted without saving the Data Option file. 

• If the current set of data options is not satisfactory, they must be changed before starting data col-
lection or data reprocessing. Once collection or reprocessing has started, it must be stopped be-
fore changes can be made. 

• Current settings can be viewed at any time by selecting Options, View Data Options. 

• The current data options can be replaced with a set of data options stored in an *.ini (a set of data 
options saved to a file), *.VMO (the option settings used for collecting the data), or *.VMP file (the 
option settings used for reprocessing the data). The current options can be edited. 

Saving Data Options 
When the current data options are changed, the old version is overwritten. To keep from losing a set of 
options, they should be stored in a file by clicking Options, Save As. 

• The Save As option is available only when options have been edited but not saved in a file. 

• Choose a file name that suggests the purpose of this set of data options. VmDas will add the *.ini 
extension to the name. No extension should be supplied by the user. 

• Whenever data collection starts, the current data options are automatically saved in a *.VMO file. 

• Whenever reprocessing starts, the current data options are automatically saved in a *.VMP file. 
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• All of these files are stored as standard Windows *.ini files. They are easy to read with a text edi-
tor. Editing them directly is not recommended. 

Error Messages 
Some options or combinations of options are illegal. VmDas detects some of these bad settings and re-
fuses to allow them to be saved or to exit the menu. 

• Clicking OK on the Edit Data Options dialog box causes VmDas to do a consistency check and 
save the new settings as the current data options if no errors are found. 

• The check is also done when starting data collection. 

• If an error is found, a message describing the error will pop up and no changes will be 
saved. The user can either correct the problem, or cancel editing and lose all changes 
made. 

 

Figure 10. Example Error Message 

Loading Data Options 
On the Options menu, click Load. By default, only INI files are displayed. VMO files can be displayed by 
choosing them in the Files of type box. To display VMP files, choose all files in the Files of type box.  

 

To return to the factory default setting, select the 
C:\Users\yourname\AppData\Roaming\Teledyne RD Instruments\VmDas\Default.ini file. 

 

View the Current Data Options 
On the Options menu, click View Data Options. The same dialog opens as when editing, but no 
changes can be made. You can view the data options in the Playback mode. 

Setting up Display Options 
The Display Options determine how data is displayed.  

• They can be set for modes that display data (playback and collect).  

• They can be changed at any time when one of those two modes is active, whether or not data is 
being played or collected.  

• Graphs or charts may be erased and re-plotted because of changes to these options, but it makes 
no change to the data itself. 

• In reprocess mode, data is not displayed, so there are no settings to determine how it is displayed.  
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Edit Display Options 
Click Options, Edit Display Options to display a tabbed dialog box from which you can change the dis-
play options. Click the Reference tab to select the display units, or the velocity reference to use for pro-
files. Click the Ship Track tab to select the ship position source and the profile bins to use for the current 
stick plots. Click OK when done or use Cancel to abandon all changes to the display options. 

Reference Tab 
When you click the Reference tab (Figure 11) in the Display Options dialog box, the following display 
units and velocity reference settings are displayed and may be changed. 

 

Figure 11. Reference Tab 
Velocity Reference - Choose between None, Bottom Track, Bottom Track Water Mass Reference 
Layer, Water Current Profile Layer, Delta Position, Speed, and Speed/Dir Made Good. 

• Bottom Track Water Mass Reference Layer refers to the water-reference layer output that 
some ADCP instruments output along with the bottom track data. This layer is only available 
from BroadBand and WorkHorse ADCPs. This data is collected and recorded by these ADCPs only 
when the BK command is set to collect Water Mass Layer and the BL command has been set to 
select the section of water that will be measured to record a speed through the water. This speed 
through the water is stored in a separate location in the bottom track data. Enabling this feature 
will reference all of the profile velocities to this recorded speed through the water. This feature is 
typically enabled, only when the bottom track is not possible and navigation data will not be col-
lected. 

• The Water Current Profile Layer is setup as an independent water layer to reference the aver-
aged data in either the STA or LTA files. The user should set this to a number of consecutive bins 
that will represent only the vessel motion (i.e. that has as little real water motion as possible). The 
Start and Stop bins selected will all be averaged together to produce a single speed through the 
water. This speed through the water is stored in a separate location in computer RAM. If not used 
it is discarded and not recorded. Enabling this feature will reference all of the profile velocities to 
this recorded speed through the water. This feature is intended for use when there is no bottom 
track or navigation data available.  
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• Delta Position calculates a reference velocity as delta position divided by delta time, where the 
position data is obtained from the NMEA GGA message. The position used in the calculation is 
the first and last GGA position received in each ADCP data interval. 

• Speed calculates a reference velocity from speed and direction, obtained from the NMEA GGA or 
VTG message, by resolving them into East and North components. 

• Speed/Dir Made Good calculates a reference velocity from speed-made-good and direction-
made-good, which is in turn calculated from the averages of position and time, as received in the 
NMEA GGA or VTG messages, for each ADCP data interval. 

Velocity Units - Choose between millimeters per second, meters per second, knots, or feet per second for all 
displayed velocity data. 

Depth Units - Choose between meters, centimeters, or feet for all displayed depth data. 

Ship Track Tab 
When you click the Ship Track tab (Figure 12) in the Display Options dialog box, the following set-
tings are displayed and may be changed. Click OK when done or use Cancel to abandon all changes to 
the display options. 

 

Figure 12. Ship Track Tab (Data File Contains BB and NB Data) 
Ship Position Source - For each ship track plot, choose between NAV, Bottom Track, Water Mass Ref-
erence Layer, and Current Profile Layer. 

• If NAV is selected, the last NMEA GGA position received in each ADCP data interval is used to 
calculate the ship track, and can be displayed as a Lat/Lon position, or as a distance from the ini-
tial position received within an ADCP data interval. 
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• If Bottom Track (BT) is selected, the ADCP bottom track velocity data are integrated to calcu-
late a ship track. 

• If Bottom Track Water Mass Reference Layer is selected, the ADCP water reference layer 
data are integrated to calculate a ship track. This layer is only available in the BroadBand and 
WorkHorse ADCPs. This data is collected and recorded by these ADCPs only when the BK com-
mand is set to collect Water Mass Layer and the BL command has been set to select the water 
depths to collect a speed through the water. The delta speed and delta time between consecutive 
averaging intervals is then used to calculate a distance traveled (see Figure 9, page 35) and direc-
tion and plotted on the Ship Track graph. This feature is typically enabled only when the bottom 
track is not possible and navigation data will not be collected. 

• If Water Current Profile Layer is selected, the layer velocity is defined to be the average of the 
range of profile bins selected as the velocity reference, and that velocity is integrated to calculate a 
ship track. This layer is setup as a totally independent water layer to reference the averaged data 
in either the STA or LTA files. The user should set this to a number of consecutive bins that will 
represent only the vessel motion (i.e. that has as little real water motion as possible). The Start 
and Stop bins selected will all be averaged together to produce a single speed through the water.  

The delta speed and delta time between consecutive averaging intervals is then used to calculate a 
distance traveled (see Figure 9, page 35) and direction and plotted on the Ship Track graph. This 
feature is typically enabled only when there is no bottom track or navigation data available.  

 

If Bottom Track (BT), Bottom Track Water Mass Reference Layer, or Water Current Profile 
Layer is selected, the ship track is shown as a distance from the initial position, where the 
initial position is 0,0. 

 

Chart units for distances - Choose between Kilometers, Meters, Miles (statute), or Feet. 

Current Sticks - Choose to display up to three current sticks at each ship position, and select which profile 
bin each stick represents. 

 

Changes made to the Ship Track tab may require that the ship track be re-plotted. VmDas will 
issue a warning before accepting these changes. If the ship track must be re-plotted, the ship 
track is erased. Plotting continues from the current position.  
When collecting data, this means it is a good idea to settle on desired configurations early. 
Once erased from the display, the Ship Track cannot be redisplayed until the deployment files 
are played back. 

 

Change Chart Properties 
Whenever you right-click on any profile plot, a pop-up property menu (Figure 13) is displayed from which 
you can change many attributes for the profile graphs.  

Profile Plots 

• How do I manually set the ranges for the plot axes?  Select the Axes tab. On the right, click the 
tab that contains the attribute that you want to change for the axis, in this case Scale. On the left, 
click on the label of the axis you want to change. On the right, enter new numbers for Max and 
Min and click OK or Apply. 

 Manually changing the plot axes may cause unpredictable results. Use the Graph Toolbar to 
adjust the plot axis. 

 

• How do I put symbol markers on my data points?  Select the Chart Styles tab. On the right, 
click the Symbol Style tab. On the left, click on the label for the series you want to mark (i.e. 
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Style1, Style2, etc.). Click the box labeled Shape and select a shape for the symbol. Click the box 
labeled Size to set the size of the symbol. Click the Name box to set the desired color for the sym-
bol. Click OK or Apply. Note that from the Chart Styles tab you can also set the line width, pat-
tern, and color of each line in the graph. 

 

Figure 13. Chart Control Properties 
Ship Track Plots 

• How do I manually set the ranges for the plot axes?  Right-click the ship track plot and click on 
Properties (Figure 14). Click the Plot Area tab. Manually enter values for Left, Right, Top, 
and Bottom. On this property page, you may also change the font, turn on or off the grid lines 
and set their style, and change the aspect ratio method. Click OK. 

 Manually changing the Ship Track plot axes may cause unpredictable results. Use the Graph 
Toolbar to adjust the plot axis. 

 

 

Figure 14. Ship Track Properties Dialog 
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Data Options Screens 
Click Options, Edit Data Options to display a tabbed dialog box from which you can change the pro-
gram options.  

• Communications (see Communication Tab) 

• ADCP Setup (see ADCP Setup Tab) 

• Recording (see Recording Tab) 

• NAV (see NAV Tab) 

• Transforms (see Transform Tab) 

• Averaging (see Averaging Tab) 

• Data Screening (see Data Screening Tab) 

• Users Exits (see Users Exits Tab) 

• Simulated Inputs (see Simulated Inputs Tab) 

Editing the Data Options 
On the Options menu, click Edit Data Options to display a tabbed dialog box. Options in the Edit 
Data Options can only be changed before collecting data or before reprocessing data. When VmDas is 
collecting or processing data, the options can only be viewed. 

• Clicking OK causes VmDas to do a consistency check and save the new settings as the current 
data options. 

• On an illegal setting, a pop up message will describe the error and no changes will be saved. The 
user can either correct the problem, or cancel editing and lose all changes made. 

• Editing data options saves them as the current options, not in a file (see Saving Data Options).  

 

If the save to a file step is skipped, the current options still persist until changed, even if 
VmDas is closed. 
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Communication Tab 
When you click the Communications tab in the Program Options dialog box, the following commu-
nications settings are displayed and may be changed to match the communication parameters to those of 
the device you have connected to the computer. 

Select first the item you want to configure (top left quadrant) e.g. ADCP input or NMEA 3 input, then go 
the “Set Communication Parameters” quadrant and then enable or disable the selected port and the click 
on the button “Set” to apply the new settings.  

The top right quadrant shows the settings the software will use.  

 

Figure 15. Communications Tab 

 

If the same serial-port is selected twice, the software will not let the user continue to the 
next tab until the setting is changed. 

 

 

VmDas has UDP and TCP/IP Ethernet options. However, VmDas versions before 1.52 may 
have trouble with TCP/IP communication loss. 

 

VmDas can collect data from one to four input serial ports. When collecting data, ensembles must be read 
from the ADCP input port. The NMEA input ports can collect NMEA data if desired. If the NMEA ports 
are used see Reading NMEA Data for details on which sentences are accepted.  
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When connecting to an ADCP via Ethernet, a soft break (===) is used to wake up the ADCP, and it may 
take a number of tries to wake up the instrument. While the ADCP is pinging, interrupts are off and it will 
miss/lose the soft break characters. The ADCP must NOT go to sleep as hard breaks are not supported by 
Ethernet. The CL0 command is part of all Workhorse Command Files as of this release to prevent the 
ADCP from sleeping. 

Enabling an input port instructs VmDas to listen for data at that port, to log all data received to a file, and 
to generate error messages if data is not received. VmDas enforces some rules for input port options.  

• Duplicate or invalid COM ports cannot be specified for active ports.  

• NMEA options on the Nav or Transform tab will only be able to use NMEA ports enabled on 
the Communications tab.  

• Enabled NMEA ports will log all data they receive in an N1R, N2R, or N3R file. The user can 
choose to save GGA or VTG data in the navigation data (see Binary Navigation Data Format) on the 
NAV tab (see NAV Tab).  

VmDas can write data to up to three output serial ports and up to three TCP/IP/UDP ports.  

VmDas can provide up to three optional real time outputs through serial ports, Ethernet ports, or both.  

Enabling an output port instructs VmDas to write data to that port whether or not anyone is listening.  

Ensemble Output (Binary LTA) provides long term averaged ensembles. This output is a copy of the 
LTA output file. 

Ensemble output (ASCII) converts binary ensembles to an ASCII format. If this port is enabled, the 
data to be written must be selected in the Set Ensemble Output Configuration Here box.  

Speed Log Output produces NMEA messages containing ship speed information from short-term aver-
aged data. Data is output at the same rate as the short-term average.  

Set Ensemble Output Configuration Here 

The settings in the Set Ensemble Output Configuration Here box are needed only if Ensemble 
Output (ASCII) is selected and either Enable Serial or Enable Network is checked (see Figure 16). 

• Data Select - VmDas produces several output files with binary ensembles. Data Select chooses 
one of these files as the source of ensemble data for ASCII output. Some of the data in the binary 
source will be extracted, converted to an ASCII format (See Output ASCII Ensemble Data), and writ-
ten out the output port. 

• Data Type Switches - Select the type of data to send to the ensemble-out device during data 
collection. Check the appropriate checkbox for each type of data you want sent to the ASCII en-
semble-out port. The Navigation box will have no effect if the Data Select box contains ENR. 
Navigation data is not present in the raw ENR files. Navigation data comes from NMEA inputs. 
The navigation and ensemble data are merged to produce ENX, STA, and LTA files.  

• Velocity Switch - If the Velocity box is checked, the Start Bin and End Bin boxes in the 
Output column set the bins that will be added to the ASCII ensemble velocity data.  

• Velocity Ref - If the Velocity box is checked, the Velocity Ref box can be used to remove ship 
velocity from the velocity profile. Other velocities, such as bottom track, are not changed.  

1. If Velocity Ref is set to None, velocities are unchanged.  

2. If Velocity Ref is set to Bottom, the velocity from the bottom track field, if present, 
is subtracted from the velocity of each bin.  

3. If Velocity Ref is set to Water Current Profile Layer, the average velocity of a 
water layer is subtracted from the velocity of each bin. The Start Bin and End Bin 
boxes in the Profile Layer column select the bins that makes up the water layer. 
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• Output Start/End Bin - Lets you select the portion of the ADCP profile (depth cell range) to 
send to the ASCII ensemble-out port. 

• Profile Layer Start/End Bin - Lets you select the bin (depth cell) range for the Water Current 
Profile Layer velocity reference. 

 

Figure 16. Communications Tab - Ensemble Output (ASCII) Selected 
Set Speed Log Output Configuration Here 

If the Speed Log Output box is selected and either Enable Serial or Enable Network is checked, the 
Set Speed Log Output Configuration Here section lets you select the following parameters for the 
speed log output only (see Figure 17). 

• Data Select - Lets you select between STA Short-term averaged Earth or LTA Long-term aver-
aged Earth as the output source. 

• Water Reference Layer Source - Lets you select the reference velocity to subtract from the 
profile output. Water Current Profile Layer sets the reference velocity to the average of the user-
defined bin range in the "Profile Layer" column, and causes the reference velocity to be subtracted 
from the profile before data output. Bottom Track Water Mass Reference Layer sets bottom track 
as the reference velocity, and causes the reference velocity to be subtracted from the profile before 
output.  

• Start/End Bin - Lets you select the bin (depth cell) range for the Water Current Profile Layer 
velocity reference. 
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Figure 17. Communications Tab - Speed Log Output Selected 

 

If the start and end bins are out of range (e.g., the ADCP ensemble contains 40 bins, and you 
set the Output Start Bin = 1 and the Output End Bin = 50), VmDas automatically adjusts the 
output bin range to the ADCP ensemble (i.e., Output End Bin = 40).  

 

 

Suggested Setting.  
The parameters set in the ADCP input port should match the ADCP wakeup serial port settings. TRDI 
recommends that the ADCP wakeup serial port settings be set at 9600 BAUD, no parity, 8 data bits, 
and 1 stop bit. 
The NMEA 1, 2, and 3 ports read NMEA data. The NMEA 0183 standard specifies 4800 BAUD, no 
parity, 8 data bits, and 1 stop bit. Never the less, many ships use 9600 BAUD, and some may use 
faster rates. 

 

 

Advanced users can change the ADCP serial port parameters with a command file. Those 
parameters are used only while collecting data. When data collection stops, the serial port 
settings the ADCP uses will return to their wakeup values.  
VmDas automatically changes the PC serial port when the ADCP serial port changes. 
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ADCP Setup Tab 
Use this dialog box to setup the ADCP. Select either Use Options to set the ADCP commands on this tab 
or select Use File to use a command file (see Table 2 for a description of each command file).  

 

Figure 18. ADCP Setup Tab 
Ensemble Time is set on this tab for both Use Options and Use File. Select the Set time between 
ensembles button to specify a ping interval (see Table 3). Select the Ping as fast as possible button to 
let the processing and I/O time dictate the ping rate. 

Table 3: Ensemble Time 
Frequency (kHz) With Bottom Track (sec) Without Bottom Track (sec) 

38 4 2 

75 2 1 

150 1 1 

300 

Select Ping as Fast as possible 600 

1200 
 

 

See Detailed ADCP Initialization for details on how the ADCP commands are generated and 
sent to the ADCP. 
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To set the ADCP commands using this dialog box, select the Use Options button. 

• Select the Set Profile Parameters box in the Water Current Profile section to set the fol-
lowing parameters; Number of Bins (WN), Bin Size (WS), Blank Distance (WF), and 
Transducer Depth (ED).  

• Select the Set Processing Mode box to switch between high and low resolution modes.  

• Select the Set BT on/off box to enable or disable bottom track pings (BP1) and set the maximum 
search range (BX command).  

• Select the Heading Sensor Set Sensor Type box in this section to switch between using the 
ADCP's internal sensor or an external analog gyro (synchro/stepper) (EZ command).  

• Select the Tilt Sensor Set Sensor Type box in this section to switch between using the ADCP's 
internal sensor or an external analog gyro (synchro) (EZ command). When this box is not 
checked, the default ADCP setup will be used. 

To set the ADCP commands using a command file, select the Use File button. Enter the name of an 
ADCP command file in the Command File box, or click the Browse button to navigate to a file using a 
File Open dialog box. This should be a text file with one ADCP command per line, and can have any valid 
ADCP commands. The contents of this file will be sent to the ADCP during initialization. 

 

Suggested Setting for First Time Users.  
Select the Use File button in the ADCP Setup file area and click the Browse button under the 
Command File window. Select one of the default command files (see  Command Files and ADCP 
Configuration) and click Open.  
Set the Ensemble Time as shown in Table 3. 

 

 

The ADCP automatically increases the Time per Ensemble if ((WP + NP + BP) x TP > the setting 
in Set time between ensembles box).  

 

On the ADCP already Pinging section, select Monitor Mode to configure VmDas to listen to the Se-
rial and/or Ethernet ports. VmDas will not configure or start the ADCP. The assumption is the ADCP is 
already configured and is already sending data to the serial port VmDas is listening to. 
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Recording Tab 
The Recording property page allows you to set the deployment name and path to where the data files are 
recorded. 

 

Figure 19. Recording Tab 
Enter a name that identifies your deployment. This name is used as part of the filename for each file that 
is part of this deployment (see File Naming Conventions). 

Normally, you do not need to enter a starting Number as the software handles it automatically. This de-
ployment number is used to identify the specific data collection run, and becomes part of the filename of 
each data file recorded for the deployment. If you do not enter a deployment number, the software will 
automatically assign one for each deployment. 

Enter the desired Maximum File Size. Each file type in your deployment will be limited to the specified 
size. Each file has a sequence number as part of the file name and as each recorded file reaches the speci-
fied size limit, the sequence number will be incremented and a new file started. It is not recommended to 
set the Maximum File Size greater than 10MB as larger files will slow data processing considerably.  

For example, a data files produced by VmDas during data collect mode has the following file name: 
RDI000_YYYYMMDDTHHMMSS_000001.enr, where: 

RDI is the user-entered name for the deployment, 

000 is the deployment number (changes with each stop/restart), 

YYYYMMDDTHHMMSS Is the date and time (if check box Use Date is selected) 

000001 is the file sequence number, which is incremented when the specified maximum file 
size is reached, and 

enr is the file extension, and reflects the type of data in the file is raw data 
 

Enter the Primary Path where the raw, intermediate, and processed data files are to be stored. Clicking 
the Browse button to the right of the Primary Path edit box will allow you to browse your computer to 
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select a folder to record to. You will be presented with a Choose Directory dialog box (see Figure 20), 
which will have the default path of C:\Program Files\Teledyne RD Instruments\VmDas selected. Select 
the primary path (note the directory must already exist) and click OK.  

 

Figure 20. Choosing the Path 
Check the Dual Output Directories box to create two copies of the raw data files and to allow a backup 
path to be entered. If this box is not checked, only the Primary Path is enabled. 

Enter the Backup Path where optional backup copies of raw data and option files are stored. These files 
are not used for data processing. They are available in case the primary files are lost. If the backup copies 
are needed, copy them to the primary directory and reprocess them to create intermediate and processed 
data files. 

 

Suggested Setting.  
Enter a file name that identifies your deployment.  
Select the primary path (note the directory must exist already; VMDAS does not create it, except for 
the default path already entered). 
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NAV Tab 
Use the NAV tab to decide whether or not to save GGA or VTG data in the NAV field of the ENS, ENX, 
STA, and LTA files. Choose which enabled ports to read it from on the drop down list. Only enabled ports 
appear in the drop down lists.  

You can enable a backup source for GGA or VTG by checking the Enable Backup box. If you choose a 
backup source, the primary source will be put into the NAV field. If primary data becomes invalid, backup 
data will be saved in the NAV field instead.  

 

Figure 21. NAV Tab 
The following examples are allowable: A user might select identical data from the same port as the pri-
mary and backup source for an option. 

• Select HDT from NMEA 1 as the primary heading source, and HDT from NMEA 2 as the 
backup.  

• Select HDT from NMEA 1 as the primary heading source and HDG from NMEA 1 as the 
backup. 

 

If the primary data drops out, there may be a problem with the instrument, cable, or data. 
For best results, select another message from a different source as backup. 
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Transform Tab 
VmDas reads single ping beam coordinate data from the ADCP. VmDas transforms the data to earth coor-
dinates and averages it. How the transformation is done depends on details of the geometry of the ADCP, 
sensors, and the platform they are mounted on (see Note About Conventions for more insight). Use this 
screen to select the Heading Source, Tilt Source, Heading Sensor Magnetic/Electrical Connec-
tions, and ADCP Alignment Correction.  

 

Figure 22. Transform Tab 
VmDas stored the heading, pitch, and roll information from the ADCP in the ADCP leader data ID. Addi-
tionally it can store heading, pitch, and roll sensor data from a NMEA device in the NMEA data ID. This 
means that your data can contain information from both a direct connection to the ADCP and from an ex-
ternal input (NMEA). The Transform tab allows you to select which of these are actually used in the 
transformation.  

Heading and Tilt Sources 

VmDas can accept heading and tilt data from five sources.  

• ADCP internal sensors 
• External sensors (gyro) connected directly to the ADCP 
• Fixed heading and tilts entered in the ADCP with a command file 
• External NMEA sensors connected to the PC 
• Fixed heading and tilts entered as options in VmDas 
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Figure 23. Transform Tab Heading Source 
For the first two data sources, heading, pitch, and roll data are obtained from the variable leader of the 
ADCP ensembles. Select the ADCP Compass heading option and the ADCP tilt Sensor tilt option to 
use them in your transformation.  

To use a VmDas generated fixed input for Heading Pitch, and Roll, select Fixed Heading and/or Fixed 
Tilts. Once selected, enter in the fixed heading or tilts you require. This information will be stored in the 
VmDas configuration file. 

To use an external sensor input that produces data in NMEA format, select the heading or tilt option that 
contains the NMEA sentence you wish to read and the NMEA Port (NMEA1, NMEA2, or NMEA3). Ex-
ternal sensor NMEA data is stored in the NMEA data ID. 

 

NMEA data is read through up to three serial ports. These serial ports must be configured on 
the Communications tab (see Communication Tab). Selecting NMEA data on the Transform 
tab without configuring the Communications tab serial ports results in an error. VmDas will 
not allow the options to be saved until the error is corrected. 

 

 

The NMEA HDG sentence contains magnetic heading, together with variation and deviation 
corrections. VmDas calculates true heading of the ship from this. When this sentence is the 
heading source, the only heading correction needed is a heading alignment error if the ADCP 
is not aligned with the ship. 

 

 

For information on using the CUSTOM option, see Using the Custom NMEA Feature. 

 

Heading Sensor Magnetic/Electrical Connections 

EV – Primary Heading Error. This is variation, the angle between magnetic north and true north. It is 
used to correct the heading from magnetic heading sensors. For degrees west, enter a negative value for 
EV and a positive value for east. For example, a magnetic variation of 3.5 degrees west should be entered 
as -3.5 for the EV value.  

EV – Backup Heading Error. If the Enable Backup Source for the Heading is enabled, then you 
can enter a Backup Heading Error. 

ADCP Alignment Correction 

EA – Heading alignment error. The Heading Alignment Error is the angle between the forward axis 
of the ADCP and the forward axis of the ship or other platform onto which it is mounted. The EA com-
mand is used to correct the heading when the heading describes the attitude of the ship. EA is the heading 
of the ADCP’s beam 3 when the ship is level and headed north. EA is positive if beam 3 is to the starboard. 
For Example, the ADCP is mounted in place on a moving ship. The Y-axis has been rotated 45 clockwise 
(+45) from the ship’s centerline. Enter 45 in the EA: Heading align error box. To enter an EA Head-
ing Alignment error, first enable the Override command file EA box.  
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EJ – Pitch alignment error. EJ is the pitch of the ship when the ADCP is level. For example, the 
amount of rotation that the ADCP’s Y-axis is physically offset from the ship’s starboard axis is 2 degrees. 
Enter 2 in the EJ Pitch alignment error box. The tilt correction is positive if the Y-axis is to the star-
board. 

EI – Roll alignment error. EI is the roll of the ship when the ADCP is level. For example, the amount 
of rotation that the ADCP’s X-axis is physically offset from the ship’s starboard axis is –1.2 degrees. Enter 
–1.2 in the EI Roll alignment error box. The tilt correction is positive if the X-axis is to the starboard. 

 

To verify the EV, EA, EJ, and EI corrections, do the Water Profile Reasonableness Test as 
shown in the ADCP Technical Manual Test section. 

 

 

If reprocessing data and heading corrections are enabled, EA, EB, and EV commands in a 
command file will have no effect. If tilt corrections are enabled, EA, EI, and EJ commands will 
have no effect. VmDas will issue its own EA0, EB0/EV0, EI0, and EJ0 commands after the 
command file has been sent to the ADCP. 

 

 

If an ensemble contains EA and EV information in its fixed leader, VmDas will apply the 
corrections in addition to other corrections entered in the Transform page.  

 

 

Figure 24. Y-Axis Alignment 

Note About Conventions 
VmDas needs the attitude (Heading, Pitch, and Roll) of the ADCP to obtain true water and bottom east 
and north components. However, heading, pitch, and roll devices sometimes describes the attitude of the 
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ADCP and other times they describe the attitude of the ship or other platform that the ADCP is mounted 
on. Sometimes heading is magnetic, sometimes true. VmDas can accept any of these.  

When describing the attitude of a ship, heading is the angle between the forward axis and true or mag-
netic north. Actually, the projection of the forward axis on the horizontal plane is used. This usually makes 
very little difference in practice. Pitch and roll describe the tilt of the mast.  

Pitch is positive if the bow is higher than the stern. Roll is positive if the port side is higher than the star-
board side. As seen from above, a clockwise rotation of the ship makes the heading increase.  

When describing the attitude of an ADCP, the ADCP takes the place of the mast. Beam 3 marks the for-
ward axis. If beam 3 points north (slanted up or down), then the heading is zero. It does not matter 
whether the system is concave or convex, or whether transducer 3 is on the north or south side of the in-
strument. Therefore, your attitude input must reflect the attitude of the ADCP, which may or may not be 
the same as the ship.  

An ADCP uses the same sign conventions as a ship. The “bow” is always the beam 3 side. The “stern” is the 
beam 4 side. Port and starboard are marked by beams 1 and 2, but which is which changes when the 
ADCP is rotated from up facing to down facing. 

Facing up or down, an ADCP has a positive pitch if the “bow” (the beam 3 side) is higher than the “stern” 
(beam 4). Roll is positive if the port side is higher than the starboard side. Heading increases as the for-
ward (beam 3) axis rotates in a clockwise direction. 

Pitch and roll should always be near zero in relation to the ship. An ADCP has an internal sensor to tell 
whether it is facing up or down. It sets an up-facing/down-facing flag in the system configuration field of 
the fixed leader in each ensemble. VmDas reads this flag and corrects internally before doing the transfor-
mation to earth coordinates.  

The unit for all angles is degrees. 
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Averaging Tab 
The Averaging property page allows you to set the Ensemble Averaging interval and Reference Layer Av-
eraging properties. 

 

Figure 25. Averaging Tab 
Enter the Temporal Averaging short-term averaging in the First Time Interval (STA) box. Use the 
short-term average to get updates more frequently for data quality checks. The First Time Interval 
(STA) is what we refer to as the Short Term Average (which will become file name with a *.STA exten-
sion).  

Enter the long-term averaging period in the Second Time Interval (LTA) box. Use the long-term aver-
age to get your intended results. The Second Time Interval (LTA) is what we refer to as the Long 
Term Average (which will become file name with a *.LTA extension).  

Enable the Profile Ping Normalization Reference Layer checkbox to turn ON or OFF the reference 
layer averaging feature. Using a Reference Layer helps removes biases caused from accelerations on plat-
forms or ships. To set up a Reference Layer, you must set the Start Bin and the End Bin to use as the 
“meaning” reference layer. 

Noise, introduced by platform accelerations, can overwhelm the velocity measurements. We have found 
keeping track of velocities relative to a stable reference layer can improve the data in such cases. As an ex-
ample, suppose we have a four-ping ensemble. Because signal amplitude falls off with distance, the deeper 
bins will have more of the data flagged as bad. Bad data are not included in averages. As a result, the aver-
age profile might be erratic when the percent good is low. In the data below, a constant profile is assumed 
for bins 20 to 22, yet the average of good data shows it to be sheared. 
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 Ping #  
 1 2 3 4  

Bin Velocities AVG #1 
1 5 6 18 19 12 
2 3 4 16 17 10 
↓ ↓ ↓ ↓ ↓ ↓ 
20 bad bad bad 16 16 
21 2 bad bad bad 2 
22 bad bad 15 bad 15 

 

Bins 1 and 2 have all good data; and in this example, are used as the reference layer. Averaging these bins 
for each ping gives a reference velocity of: 
       Ping #:             1   2    3    4 
Layer Average:             4   5   17   18 
Mean Layer Average = 11 : (4 + 5 + 17 + 18) / 4 
 

When the layer average is subtracted from the velocities within each ping the data become: 

Bin Velocities Average #1 Average #2 
1 1 1 1 1 1 12 
2 -1 -1 -1 -1 -1 10 
↓ ↓ ↓ ↓ ↓ ↓ ↓ 
20 bad bad bad -2 -2 9 
21 -2 bad bad bad -2 9 
22 bad bad -2 bad -2 9 

 

The last column, Average #2, gives a better picture of the velocities at the deeper bins than the algorithm 
for obtaining AVG #1.  

 

When using a reference layer, use bins in the upper part of the profile and bins that have a 
high percent good (more than 85%). If you select a bad bin range, the averages will be wrong 
and data will be bad. 

 

 

Suggested Setting.  
You will be collecting three different files and will be able to view all three during real time data 
collection. The first file is the raw data input, which is single ping data. The selections for the other 
two files are based on your time input values here. The First Time Interval is what we refer to as 
the Short Term Average (which will become file name with a *.STA extension). The Second Time 
Interval is what we refer to as the Long Term Average (which will become file name with a *.LTA 
extension). You can set these to any times you like and they may even be the same value.  
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Data Screening Tab 
Click the checkboxes for the data screening options you wish to enable. When a box is checked, its associ-
ated edit box becomes enabled, and you may enter a threshold value for screening the data. 

 

Figure 26. Data Screening Tab 
For RSSI (amplitude), Correlation, and Percent Good screening, the threshold value represents a 
minimum allowed value. For example, if you set the RSSI threshold to 35 counts, then any beam with an 
RSSI value below 35 counts will be discarded and not used in the processed data. RSSI and correlation 
screening for each beam are performed on the raw data. Percent good screening is performed on the aver-
aged data. 

For Error Velocity and Vertical Velocity screening, the threshold value represents a maximum al-
lowed value. For example, if you set the Error Velocity threshold to 1500 mm/s, then any transformed 
ensemble that has an error velocity greater than 1500 mm/s will be discarded and not used in the pro-
cessed data. Error Velocity and Vertical Velocity screening are performed on the transformed data, 
before averaging. 

For Fish screening (also known as false-target detection), the threshold used for bottom track is based on 
percentage, and the water track ping and profile ping is based on counts.  

Check the box labeled Mark Data Bad Below Bottom to have the software mark bad all profile bins 
that fall below the sea bottom. The formula is LastGoodBin = (ShallowestBeam) * (COS (BeamAngle)) + 
(BinLength).  

 

The ADCP has its own internal thresholds. Setting thresholds on this page that is lower than 
those used by the ADCP will have no effect.  
While it is possible for advanced users to modify the ADCP command file to disable some of 
the internal thresholds, this practice is not recommended. VmDas is designed to do those 
checks. It allows you to change them when you reprocess the data. This gives you the 
maximum flexibility.  
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Determining the End of Range for Narrowband Profiles 

The STD Error Vel screening threshold allows a convenient way to set the end of the profiling range for 
the Narrow Bandwidth data collected by a Pinnacle 45 ADCP. This screening is applied to the data rec-
orded in the averaged files (STA and LTA) by specifying a multiplier on the expected standard deviation 
for the bin size. That is, if a STD Error Vel of 2 is set (default) then the STA and LTA files will screen out 
any bins whose calculated Error Velocity standard deviation exceeds twice the theoretical value. Increas-
ing this value will decrease the amount of screening applied and extend range, but with increased stand-
ard deviations in these bins.  

 

Figure 27. Pinnacle 45 NarrowBand Error Velocity STD Screening 

 

This screening can be used on the Ocean Surveyor and Ocean Observer ADCPs, however, it provides limited benefit 
and is therefore not recommended for use with these products. 

 

 

Suggested Setting.  
You are able to screen data based on the items in this menu and the thresholds you decide during 
real-time or when reprocessing. This screening will affect what is displayed on the screen and what 
data is recorded to the *.STA and *.LTA files. The original raw data will be unaffected by what is 
setup here. For real-time data collection, we recommend you only enable Mark Bad Below Bottom. 
You can reprocess data later and change the settings in this screen to see what the effect is on the 
data. 
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Users Exits Tab 
Click the Launch WinADCP checkbox to have VmDas automatically start the WinADCP application in 
monitor mode when data collection is started. When in monitor mode, WinADCP will periodically refresh 
its displays from the data recorded by VmDas, and will allow you to view time series and contour graphs 
of the data. From the WinADCP application menu, you can exit the monitor mode to change the 
WinADCP setup, and then reenter the monitor mode to continue the data updates. The WinADCP appli-
cation must be installed on the computer for this option to work. 

Enter the WinADCP program file name in the WinADCP Path box, including the entire path for the di-
rectory in which it resides. VmDas uses this information to find the WinADCP application. Alternatively, 
you may click the Browse button to navigate using the File Open dialog. 

Select which type of data to view with WinADCP using the Data File to Open box. Choose from single-
ping beam data (ENR), single-ping screened beam data, single-ping Earth data (ENX), short-term aver-
aged data (STA), or long-term averaged data (LTA). Once data collection has started, you can use the 
WinADCP application menu to open a different file type if desired. Just remember to exit the monitor 
mode in order to make the change, then reenter monitor mode to continue the automatic data refreshing. 

Enter the number of seconds that WinADCP should wait between screen refreshes in the Refresh Inter-
val (sec) box. 

 

Figure 28. Users Exits Tab 
 

 

When you press Stop, VmDas leaves WinADCP open so that your data screen does not 
disappear. A consequence of that is if you have WinADCP enabled as a User Exit, and click Go, 
Stop, Go in VmDas, it will cause a second instance of WinADCP to run. 
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Suggested Setting.  
If you want to view the data using WinADCP, select the Launch WinADCP box. Enter the path to the 
WinADCP program using the Browse button. VmDas will automatically enter the default path. 
Select what file you want to view in the Data File to Open drop-down list. Select a Refresh Rate 
equal to your STA or LTA file average. The WinADCP program will check VmDas for new data based 
on the Refresh Rate. 

Simulated Inputs Tab 
Use the simulated data files to help learn how to use VmDas. 

 

Enabling the simulated data will automatically disable the serial port communications setting 
for the corresponding items on the communication setup tab. 

 

 

Figure 29. Simulated Inputs Tab 
ADCP Data Simulation   

There are two simulation modes for the ADCP data.  
Simulate ADCP data from a pre-recorded file (Serial port disabled) – When you select this sim-
ulation mode, you collect data from an ENR file: VmDas pretends it came from an ADCP. You need not 
have an ADCP connected to do this. When this mode is selected, you cannot setup the serial ports on the 
Communications tab. Changing settings on the ADCP Setup tab is allowed, but it does not change the 
simulated data “collected” from the file. When data collection starts (start simulating), the serial port is 
not opened. Instead, the file is read. VmDas will end the simulation when it reaches the end of the file.  

Generate simulated data for a real ADCP collecting in air – The second ADCP simulation mode is 
much more realistic than the first mode. It “collects” data at your desk. Running an ADCP in air gives you 
bad data: this simulation mode replaces it with fake, but valid, data. You need an ADCP to use this mode.  



 

P/N 95A-6015-00 (January 2024) VmDas Software User’s Guide 

 

Page 72 EAR99 Technology Subject to Restrictions Contained on the Cover Page.  
 

On the Sim Inputs tab, check the radio button labeled Generate simulated data for a real ADCP 
collecting in air.  

 OS and OO systems should not ping with their transducers in air. For these systems, this sim-
ulation mode can be used with the transducer disconnected from the deck box. 

 

Configure the serial port on the Communications tab and set the options on the ADCP Setup tab as if 
really collecting data. When collection starts, VmDas sets up the serial port, configures the ADCP, and be-
gins collecting data. As VmDas reads each ensemble, it looks for the profile velocity, NB profile velocity, 
and BT fields. VmDas substitutes fake data into the fields it finds. The ensembles with fake data are writ-
ten to the ENR file.  

The BB and NB velocity profiles are set to  

Bin Beam 1 Beam 2 Beam 3 Beam 4 

1 100 -100 0 0 

2 101 -101 1 -1 

3 102 -102 2 -2 

↓ ↓ ↓ ↓ ↓ 
 

For bottom track, bottom and water track velocity is set to  

Beam 1 Beam 2 Beam 3 Beam 4 

0 0 1000 -1000 
 

Range to the bottom is set to  

Beam 1 Beam 2 Beam 3 Beam 4 

10100 10200 10300 10400 
 

Percent good is set to  

Beam 1 Beam 2 Beam 3 Beam 4 

100 100 100 100 
 

All velocities are mm/s. Range to the bottom is cm. Percent good is percent.  

NMEA Data Simulation   

NMEA/Simrad simulation mode lets VmDas read data from the NMEA ports without controlling the 
NMEA/Simrad instruments. No instruments are used in this mode.  

On the Sim Inputs tab, check the Simulate NMEA or Simrad data (Serial port disabled) radio 
button. Choose what ports to “collect” NMEA or Simrad data on the Communications tab. Configure 
the port as normal, but the only configuration that matters is whether the port is enabled. Enabled ports 
will be available as data sources on the NAV and Transform tabs as usual.  

When collection starts, a configuration dialog appears for each enabled simulated port. The user can 
change the type of data or content of the data at any time by changing settings in the dialog and clicking 
Update (see Figure 30). Click the Data Setup button to go to the Simulated Ship Setup screen (see 
Figure 31).  
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The user can move the dialogs, but not hide them. 

 

 

Figure 30. NMEA Simulation Settings 

 

Figure 31. Simulated Ship Setup Screen 
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Figure 32. Simulating Invalid Data 

 

Figure 33. Simulating No Data 
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CH A P T E R  4  –  CO M M A N D  F I L E S  A N D  ADCP CO N F I G U R A T I O N  

 
 

Chapter 4 

COMMAND FILES & ADCP 

CONFIGURATION 

 

 

In this chapter:  

• Creating Command Files 

• How VmDas uses Command Files 

• Detailed ADCP Initialization 
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This section describes how to create a command file. To use an existing command file, see ADCP Setup Tab. 
Command files provide a way to configure the ADCP with user-selected commands as data collection be-
gins. This provides the advanced user with more control than is possible by having VmDas configure the 
ADCP from user selected options.  

Example Command Files 
VmDas ships with several example command files, described in Table 2.  

• These command files are usable as they are. They will configure an ADCP with reasonable gen-
eral-purpose settings.  

• Each command file is intended for a specific ADCP. There are example files for Broadband, Work-
horse, and Ocean Surveyors. Navigators should start with a Broadband file and edit it as de-
scribed in the next section.  

• For VmDas purposes, an Ocean Observer is the same as an Ocean Surveyor.  

Creating Command Files 
To create a new command file, do the following. 

1.  Make a copy of one of the default command files (see Table 2) and give it a new name. VmDas ex-
pects command files to have a txt extension, but other extensions can be used. 

2. Open the copy in NotePad® or a similar type of text editor. Do not use editors such as WordPad® 
or word processors such as Word® or WordPerfect® because they add hidden characters to the 
file for formatting.  

3. Edit the commands as needed. Refer to the ADCP Technical Manual for detailed information on 
each command.  

4. You may want to add or edit commands, but most commands should not be deleted. Deleting a 
command leaves the configuration dependent on the ADCP’s command default setting. This can 
cause the configuration to change unexpectedly if the command file is used with a different ADCP 
or the same ADCP with a new firmware version.  

5. Save the file.  

6. Test the new command file with the ADCP that the file is intended to configure. The ADCP must be 
in water. 

 NEVER ping an Ocean Surveyor/Observer while the transducer is in air. This will damage the 
electronic chassis. 

 

Open VmDas in data collection mode. Edit the options and set the command file as described in 
the ADCP Setup Tab. Begin collecting data. If data collection starts normally and VmDas begins dis-
playing data (even bad data), the test is passed.  

7. If any command causes an error, VmDas will stop the initialization process and start over. This cy-
cle will repeat indefinitely. If this happens, stop data collection and use Notepad® to look in the 
log file. An error message will pinpoint the offending command.  
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Command File Basics 
A command file provides instructions to the ADCP for profiling setup, bottom track, and ADCP sensor 
source (internal such as the flux-gate compass or external such as the synchro or stepper gyro input). The 
following describes how to create or modify a command file. 

• A command file should contain only ASCII characters. Each line should end with a Carriage Re-
turn.  

• Use an ASCII text editor (e.g. Notepad®) to create a command file.  

• Every line in a command file should be a command, a comment, or blank.  

• Lines starting with a ‘;’ (semicolon) are comments and will not be sent to the instrument.  

 

The default command files have comments that explain the function of each command. It is a 
good idea to keep the comments and edit them when you make command changes.  

 

• ADCP’s mostly use the same set of commands, but there are minor differences. Consult the ADCP 
technical manual for a particular ADCP for details of its commands.  

• Commands are not case sensitive. 

The following shows the printout of the default command file OS38BBDEF.txt.  
;-----------------------------------------------------------------------------\ 
; ADCP Command File for use with VmDas software. 
;  
; ADCP type:     38 Khz Ocean Surveyor 
; Setup name:    default 
; Setup type:    High resolution, short range profile (broadband) 
;  
; NOTE:  Any line beginning with a semicolon in the first  
;        column is treated as a comment and is ignored by  
;        the VmDas software. 
; 
; NOTE:  This file is best viewed with a fixed-point font (eg. courier). 
; Modified Last: 12August2003 
;----------------------------------------------------------------------------/ 
 
; Restore factory default settings in the ADCP 
cr1 
 
; set the data collection baud rate to 38400 bps,  
; no parity, one stop bit, 8 data bits 
; NOTE:  VmDas sends baud rate change command after all other commands in  
; this file, so that it is not made permanent by a CK command. 
cb611 
 
; Set for broadband single-ping profile mode (WP), forty (WN) 24 meter bins (WS), 
; 16 meter blanking distance (WF), 390 cm/s ambiguity vel (WV) 
NP0 
WP00001 
WN040 
WS2400 
WF1600 
WV390 
 
; Enable single-ping bottom track (BP),  
; Set maximum bottom search depth to 2000 meters (BX) 
BP001 
BX20000 
 
; output velocity, correlation, echo intensity, percent good 
WD1110000001 
 
; Three seconds between bottom and water pings 
TP000300 
 
; Six seconds between ensembles 
; Since VmDas uses manual pinging, TE is ignored by the ADCP. 
; You must set the time between ensemble in the VmDas Communication options 
TE00000600 
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; Set to calculate speed-of-sound, no depth sensor, external synchro heading  
; sensor, no pitch or roll being used, no salinity sensor, use internal transducer  
; temperature sensor 
EZ1020001 
 
; Output beam data (rotations are done in software) 
EX00000 
 
; Set transducer misalignment (hundredths of degrees) 
EA00000 
 
; Set transducer depth to (decimeters) 
ED00000 
 
; Set Salinity (ppt) 
ES35 
 
; save this setup to non-volatile memory in the ADCP 
CK 
 

Commands that should be in a Command File 
ADCP’s mostly use the same set of commands, but there are minor differences. Consult the technical man-
ual for a particular ADCP for details of its commands. In addition, some commands are not appropriate 
for all ADCP’s. For example, only the Ocean Surveyor understands commands such as NP, EI, and EJ. 
They will cause errors if sent to other kinds of ADCP’s.  

For TRDI recommendations on which commands should be used with which ADCP, check the example 
command file for the ADCP.  

Restore Factory Defaults 

CR1 

It is a good idea to restore the ADCP to the known factory default configuration before starting. CR1 
should be the first command in the file.  

Data fields 

WD 

Edit this to turn on or off each kind of data to record in the output file.  

Profile 

 WP, NP, or both 

For VmDas to perform correctly, command files must set the ADCP for single ping data. This means ei-
ther a WP1 or NP1 or both (this is new in VmDas version 1.44) command(s) must be present if velocity 
profile data is desired. For no profile data, WP0 or NP0 must be set in the command file. 

The Navigator only recognizes the WP command if the current profile feature is installed. It should not be 
in command files intended for Navigators without this upgrade.  

Command files for Ocean Surveyors should include NP1 or NP0. Other ADCPs do not recognize this com-
mand, and should not have it.  

WS, WF, WN, WV (or NS, NF, NN for Ocean Surveyors using the NP1 command) 
These commands configure the velocity profile. Edit these to fit the ADCP and deployment. Omit them for 
ADCPs that do not have water pings. 

Bottom Track 

BP 

For VmDas to perform correctly, command files must set the ADCP for single ping data. This means a BP1 
command must be present if bottom track data is desired, or BP0 if not. 
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Some Workhorses do not recognize the BP command unless they have the Bottom Track upgrade in-
stalled. It should not be in command files intended for Workhorses without this upgrade. 

BX 

This sets the maximum bottom tracking depth the ADCP will use. Edit it to fit the ADCP and deployment.  

Some Workhorses do not recognize the BX command unless they have the Bottom Track feature upgrade 
installed. It should not be in command files intended for Workhorses without this upgrade. 

Timing 

TP 

This sets the time between bottom track and water pings. It is the only timing command that normally 
needs to be in the command file.  

TE 

This is not needed since VmDas does single pinging; it and other timing commands have no effect. It is 
present so that a user reading the file will see it, read the accompanying comment, and understands that 
timing is controlled by the ADCP Setup tab in the options.  

Coordinate Transformation 

EX00000 

VmDas requires the data to be in beam coordinates. VmDas will then transform the data to earth coordi-
nates. VmDas will over-write any EX values to EX00000 in the ADCP command text file. 

 

The automatically generated EX00000 command is not stored by the CK command. If the 
ADCP were to be used with another program without setting the EX command in the 
command file, it would not have the same configuration. 

 

External Sensors 

EZ 

The EZ-command tells the ADCP to use data from a manual setting or from an associated sensor. When a 
switch value is nonzero, the ADCP overrides the manual E-command setting and uses data from the ap-
propriate sensor. If no sensor is available, the ADCP defaults to the manual E-command setting in instru-
ment coordinates regardless of the coordinate frame parameter of the E-command setting. The example 
command files contain either EZ1020001 for shipboard use or EZ1111111 for a stationary deployment 
(such as Oil Rig platforms). Edit this command as needed.  

ED 

The ED command sets the transducer depth. Edit this to fit the ADCP and deployment.  

Store to Nonvolatile Memory 
CK 

This command stores the ADCP’s current configuration in the ADCP’s nonvolatile memory, so that the 
ADCP wakes up in the same state after being shut down. All commands above CK in the command file (ex-
cept CB, see below) will be permanently stored. Commands sent after the CK command will not be saved. 
Make sure CK is the last command in the command file.  

VmDas sends commands after the command file is done. These commands are not stored in non-volatile 
memory.  

Serial Port Configuration 

CB 

This command configures the ADCP’s serial port. VmDas watches for the CB command and provides the 
special handling that it needs. 
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First, VmDas reads the CB command before sending it to the ADCP. After the command is sent, VmDas 
configures the PC serial port to match the ADCP. Communication is not lost.  

Second, it is very important that the ADCP wake up with its serial port in a known state. This state need 
not be the same as a high-speed configuration desired for transmitting.  

VmDas provides for keeping the wakeup and data collection serial port configurations separate. VmDas 
does not send the CB command immediately upon reading it in the command file. The CB command is 
sent after all other commands in the command file are sent. This means that the CB command will never 
be saved because it is sent after the CK command. VmDas will not change the wakeup serial port configu-
ration.  

How VmDas uses Command Files 
When Use File is selected in the ADCP Setup tab, the commands in the command are sent to the ADCP. 
The same command file can be used for several deployments. Whenever data collection starts, VmDas 
copies the current options into a VMO file. This includes the path and filename of the command file, if 
any. The command file itself is not copied into the VMO file.  

When data collection starts, VmDas sends commands to the ADCP to configure it. VmDas creates some of 
the commands. Others are taken from the command file, if the options are set to do so. VmDas may edit 
the commands in the command file before sending them to the ADCP, as described in Detailed ADCP Initiali-
zation.  

VmDas creates a log file (extension LOG) whenever data collection is started. This file contains the com-
mands sent to the ADCP, the replies returned by the ADCP, and some auxiliary information such as time 
stamps.  

When configuring an ADCP, VmDas sends commands one at a time, and waits for a response after each 
line. If VmDas does not receive a response or the response is an error message, initialization fails. VmDas 
will start initialization over again. VmDas will keep trying until it succeeds or the program is stopped.  

Detailed ADCP Initialization 

Choosing Setup Parameters 
As VmDas begins collecting data, it configures the ADCP by sending it commands. Which commands are 
sent depends partly on options the user selects and partly on the type of ADCP.  

The major choices the user makes are in the ADCP Setup tab of the options dialog. The primary choice is 
Use Options or Use File.  

Selecting Use Options activates more user options. VmDas creates commands from the options.  

Selecting Use File causes VmDas to configure the ADCP by reading commands from a command file, as 
described earlier in this section.  

Either way, VmDas adds commands of its own. Some commands depend on options the user has selected 
or the type of ADCP connected. It should be noted that VmDas will override a command in a command 
file if it will setup the ADCP in such a way that it would conflict with VmDas ability to process the data. 
The following sections explain the specific commands that are over written.  

Manual pinging 

VmDas always generates a CF 0111x command, where x indicates that the last bit is unchanged from its 
current setting. This bit controls the recorder.  
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This setup places the ADCP in a Manual Ensemble mode. A Manual Ensemble mode means that VmDas 
controls the timing of ADCP ensembles and therefore the TE and TP commands are ignored. VmDas sets 
up the ADCP for single ping Water Profile and single ping Bottom Track (if Bottom Track is required). Be-
cause of this setting, the ADCP ensemble can be thought of as a ping and thus manual pinging. 

Beam Coordinates 

VmDas always generates an EX00000 command. This places the ADCP in Beam Coordinates. With the 
ADCP in Beam Coordinates, VmDas is able to perform the transformations to Earth Coordinates. The ad-
vantage of this is VmDas can interface with external Heading, Pitch, and Roll sensors and therefore it can 
be setup to use either the internal or external input for this information. 

Heading and Tilt Corrections  

Depending on options the user has selected and the type of ADCP, VmDas may generate EA0, EB0, EV0, 
EI0, or EJ0 commands (EV0, EI0, and EJ0 are generated for Ocean Surveyor with recent firmware only).  

The EA0 and EB0 or EV0 commands are generated only if setting up from options (not a command file) 
and the heading corrections options are disabled. The EI0 and EJ0 commands are generated for Ocean 
Surveyor systems if setting up from options.  

Detailed ADCP Initialization Procedure 
When configuring an ADCP, VmDas automatically does the following. 

1. Open the serial port using the settings from the Communications tab. 

2. Send a break. The ADCPSoftBreak field in the INI file [ADCP Port Options] section is used to alter 
the type of a break VmDas sends through the ADCP port. When the field is set to FALSE (default) a 
Hard Break will be sent. If the field is set to TRUE, then a Soft Break composed of “===\r” will be 
sent. 

3. Interpret the ADCP’s response to the break to determine what kind of ADCP is present.  

4. For OS, Initialize the ADCP time to the PC time with a TS command. 

5. If a command file is selected, copy it to the ADCP one line at a time with the following caveats. 

• Letters are converted to upper case. 

• Comments (lines starting with ;) are ignored. 

• CS (Start Pinging) and CZ (Power Down) commands are not sent. 

• Baud rate commands (CB) are held until all other commands in the file have been sent  

• After each line, a check is done for an error message from the ADCP. If one is found, no further 
commands from the file are sent. Initialization will start over. 

• Immediately after sending a CB command, change the PC serial port parameters to match the CB 
command. 

6. For BB, WH, and NV, read the beam-to-instrument transformation matrix. Write it to a log on 
the hard disk.  

7. If Use Options was selected on the ADCP Setup tab VmDas will generate commands based on 
user selections and send them to the ADCP. User options are enabled and disabled by check boxes 
on the ADCP Setup tab (see ADCP Setup Tab). If the check box is unchecked, the ADCP Setup tab 
will not generate the commands, and the current ADCP settings will be used. 

Bottom track 

• If the Set BT On/Off check box is unchecked, nothing is sent.  

• If Off is selected, BP0 is sent. 
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• If On is selected, BP1 and a BX command created from the ADCP Setup tab maximum range is 
sent. 

Processing Mode 

• If the Set Processing Mode check box is unchecked, nothing is sent.  

• Different commands are sent to different types of ADCP, as shown in the tables below.  

• If Hi-resolution (short range) option is selected, the following commands are sent. 

Command Command Description ADCP Type 

NP0 NB mode Pings per Ensemble OS 

WP1 Pings per Ensemble OS,BB,WH, NV 

WM1 WT Profiling Mode BB,WH, NV 

WB0 Mode 1 WT Bandwidth BB,WH, NV 

WV650 WT Mode 1 Ambiguity Velocity BB 

WV480 WT Mode 1 Ambiguity Velocity WH, NV 

<none>  All others 
 

• If Low-resolution (long range) option is selected, the following commands are sent. 

Command Command Description ADCP type 

WP0 Pings per Ensemble OS 

NP1 NB mode Pings per Ensemble OS 

WP1 Pings per Ensemble BB,WH, NV 

WM1 WT Profiling Mode BB,WH, NV 

WB1 Mode 1 WT Bandwidth BB,WH, NV 

WV330 WT Mode 1 Ambiguity Velocity BB, WH, NV 

<none>  All others 
 

Profile Parameters 

• If the Set Profile Parameters check box is unchecked, nothing is sent.  

• For BB, WH, NV type of ADCPs or OS in high-resolution mode, the following commands are con-
structed and sent. 

Command ADCP setup tab data source 

WN Number of Bins 

WS Bin Size 

WF Blank Distance 

ED Transducer Depth 
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• For OS in low-resolution mode, the following commands are constructed and sent.  

Command ADCP setup tab data source 

NN Number of Bins 

NS Bin Size 

NF Blank Distance 

ED Transducer Depth 
 

8. Send commands for flow control, heading and tilt corrections, and coordinate transformations. 

Flow Control 

• This command is always sent.  

• The current CF setting is read from the ADCP. A new command is generated using the last bit (the 
recorder bit) of the current setting.  

• CF 0111x is sent. 

Heading and Tilt Corrections 

• If the user has selected Use Options on the ADCP Setup tab of the options, he does not intend to 
send his own commands. VmDas will send EI0 and EJ0 if appropriate for the ADCP, as shown 
below.  

• If the user has selected Use Options and disabled tilt corrections, VmDas will send EA0 and 
EB0/EV0. 

• If the user has selected Use File, but has enabled Heading Corrections on the Transform tab, 
the user does not intend to send EA, EB, or EV commands. VmDas will send the appropriate 
ones.  

• If the user has selected Use File and has enabled Tilt Corrections, the user does not intend to 
send EA, EI, or EJ. VmDas will send them, as appropriate.  

Command Command Description ADCP Type 

EA0 Heading alignment correction All 

EB0 Magnetic variation All except OS with recent firmware 

EV0 Magnetic variation OS with recent firmware 

EI0 Roll alignment OS with recent firmware 

EJ0 Pitch alignment OS with recent firmware 
 

Coordinate Transformation 

• Beam coordinates. EX00000 is always sent. 
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NOTES 
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CH A P T E R  5  –  RE P R O C E S S I N G  DA T A  W I T H  VM DA S  

 
 

Chapter 5 

REPROCESSING DATA 

 

 

In this chapter:  

• Reprocessing Data 

• Playback a Data File 
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Reprocessing Data 
Reprocessing data allows you to change the settings in the Averaging and Data Screening tabs to see 
what the effect it has on the data. You are able to screen data based on the items in these menus and the 
thresholds you decide during real-time or when reprocessing. This screening will affect what is displayed 
on the screen and what data is recorded to the *.STA and *.LTA files. The original raw data will be unaf-
fected by what is setup here.  

1. Start VmDas. Click File, Reprocess Data. 

2. Browse and locate the *.vmo file for the data you wish to reprocess. For this example, select the 
SAMPLE002_000000.VMO file. Click Open (see File Naming Conventions). 

 

Figure 34. Select VMO File 
3. Click Options, Edit Data Options. 

4. Click the Recording tab (see Recording Tab). 

• Verify the Name of the data set matches the *.VMO file you wish to reprocess. 

• Verify the Number of the data set matches the *.VMO file you wish to reprocess. 
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Figure 35. Reprocessing Data – Recorder Tab 
5. Click the Transforms tab (see Transform Tab). 

• The Heading Source needs to be selected for the input you intend to use. If you will use the 
gyro heading being fed into the ADCP real time then leave it selected to ADCP.  

• The Tilt Source needs to be selected for the input you intend to use.  

6. Click the Averaging tab (see Averaging Tab). 

• Enter a time value for the First Time Interval. This is the Short Term Average (which will be-
come file name with a *.STA extension). Enter a time value for the Second Time Interval. 
This is the Long Term Average (which will become file name with a *.LTA extension). You can 
set these to any times you like and they may even be the same.  

7. Click the Data Screening tab. 

• You are able to screen data based on the items in this menu and the thresholds you decide. This 
screening will affect what is displayed on the screen and what data is recorded to the *.STA and 
*.LTA files. The original raw data will be unaffected by what is setup here.  

8. Click OK to exit the Edit Data Options screen. 

9. Save the User Option file by clicking Options, Save As. 

• Enter a file name for the *.ini file that you have just created.  
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10. To start data reprocessing, on the Control menu, click Go. You should see the Ensemble number 
increase on the Processing Bar during reprocessing. If the Processing Bar is not visible, Click 
View, Processing Bar. When reprocessing is done, you will see the message “Done!” next to the 
toolbar. 

 

Figure 36. Reprocessing Done Message 

 

No data is displayed when reprocessing data. Playback the data file to see the results. 

 

 

VmDas versions 1.44 and above adds version information to the configuration files. If no 
configuration information is present when VmDas reprocesses a deployment, VmDas 
assumes that the configuration files are old. In this case, it sets new options to values that 
mimic older versions of VmDas. 
Older versions of VmDas do not generate or recognize the options for *.N3R files. The new 
choices requires that the options to be saved in VmDasAutoConfig.ini, the deployment VMO 
files, and reprocessed VMP configuration files. Older versions of VmDas will take NAV and 
RPH NMEA data from their accustomed files for reprocessing.  
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Playback a Data File 
1. Start VmDas. Click File, Playback Data. 

2. Browse and locate the data file for the data you wish to view. Click Open. 

 

VmDas will automatically search for *.enr, *.enx, *.sta, and *.lta files.  
In order to view files that use other naming conventions, the user can either type the file 
name directly into the File name field of the Open File dialog box, or click in the Files of type 
box to select the All files (*.*) filter from the drop-down list.  

 

3. On the Playback Tool Bar, click Play.  

4. Use the Window Toolbar to display the desired graphs and then click the Resize button to ar-
range the graphs. See Tutorial – Configuring VmDas Displays for more information on the Toolbars 
and displays. 

 

Figure 37. Playing Back a Data File 
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NOTES 

 

 

 

 

  



 

VmDas Software User’s Guide P/N 95A-6015-00 (January 2024) 

 

 
EAR99 Technology Subject to Restrictions Contained on the Cover Page. Page 91 

 

CH A P T E R  6  –  NME A DA T A 

 
 

Chapter 6 

NMEA DATA 

 

 

In this chapter:  

• General NMEA Data Format 

• NMEA Input 

• Using the Custom NMEA Feature 

• NMEA Output 

• Internal NMEA Messages 
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VmDas can read in, decode, and record ensembles from an ADCP and NMEA data from some specific (i.e. 
GPS and attitude sensors) external devices. VmDas stores this data in the raw NMEA data files (N1R, 
N2R, and N3R) (leaving all original data input in its original format) and in a combined, averaged data 
file. VmDas uses all of this data to create different displays for the user. 

As well as being able to input NMEA strings to VmDas, it can produce NMEA output strings of speed log 
information. The speed log contains VDVBW (ground/water speed), VDDBT (depth), VDHDT (Heading 
True), and VDZDA (UTC Time and Date). 

General NMEA Data Format 
Much of the following information was abstracted from the NMEA 0183 standard. Discussion is limited to 
NMEA strings that VmDas understands. All NMEA messages are ASCII strings with the general format as 
shown in Table 4. 

Table 4: NMEA Data Format 
String Description 

$ HEX 24 – start of sentence 

<Address field> Approved address fields consist of five characters defined by the NMEA 0183 standard. The first two charac-
ters are the TALKER identifier. The next three characters identify the message. 

The proprietary address field consists of the proprietary character “P” followed by a three-character Manu-
facturer’s Mnemonic Code, used to identify the TALKER issuing a proprietary sentence, and any additional 
characters as required.  

(VmDas accepts any two valid characters as the TALKER identifier in approved address fields.) 

(Teledyne RD Instruments uses the TRDI Mnemonic Code for proprietary address fields, even though it is as-
signed to Radar Devices. VmDas also uses the unassigned ADC Mnemonic Code for its own data files). 

[“,”<data field>] 
. 
. 
. 

[“,”<data field>] 

Zero or more data fields, each preceded by a “,” (comma, HEX 2C) delimiter. 

The number of data fields and their content are determined by the address field. 

Data fields may be null (contain no characters). The comma delimiter is required even when a data field is 
null. 

[“*”checksum field ] Checksum 

The checksum is the 8-bit exclusive OR of all characters in the sentence, including “,” delimiters, between but 
not including the “$” and the “*” delimiters. 

The hexadecimal value of the most significant and least significant 4 its of the result are converted to two 
ASCII characters (0-9, A-F) for transmission, The most significant character is transmitted first.  

<CR><LF> HEX 0D 0A – End of sentence 
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Data Fields 

Detailed descriptions of each message VmDas uses are provided below. These descriptions use format 
specifiers for data fields. The meanings of some of the formats are listed in Table 5.  

Table 5: Data Fields 
Field Description 

hhmmss.ss A mixed fixed/variable length time field. 2 fixed digits of hours, 2 fixed digits of minutes, 2 fixed digits of seconds, and 
a variable number of digits for decimal-fraction of seconds.  

Leading zeros are always included for hours, minutes, and seconds to maintain fixed length. The decimal point and 
associated decimal-fraction are optional if full resolution is not required. 

x.x A variable length integer or floating numeric field with optional leading and trailing zeros. The decimal point and as-
sociated decimal-fraction are optional if full resolution is not required. (example: 73.10 = 73.1 = 073.1 = 73). 

A negative sign “-“ (HEX 2D) is the first character if the value is negative. The sign is omitted if value is positive.  

hh A fixed length HEX number. The most significant digit is on the left. 

a 
aa 
aaa 
etc. 

A fixed length alpha field. This type of field contains a fixed number of upper-case or lower-case alpha characters.  

In all strings recognized by VmDas, all these fields have a length of one character. 

x 
xx 
xxx 
etc. 

A fixed length numeric field. This type of field contains a fixed number of numeric characters (0 - 9).  

Some fields allow negative values. If needed, a negative sign “-“ (HEX 2D) is the first character, increasing the length 
of the field by one. The sign is omitted if value is positive. 

A A single character status field.  

A = Yes, Data Valid, or Warning Flag Clear.  

V = No, Data Invalid, or Warning Flag Set. 

Other single letter A single character field with fixed content. The letter is the content of the data field.  

When used below, the HEX value of the letter is also given. 

 

 

Spaces should not be used anywhere in these NMEA strings. Spaces may only be used in 
variable text fields. No NMEA string recognized by VmDas uses a variable text field. 
If data is not available or unreliable, a null field is used. A null field is a field with no 
characters in it. When a null field is present, two delimiters (comma, *, or <CR>) are found 
side by side. A null field does NOT contain the zero character (HEX 30), the ASCII NUL 
character (HEX 00), a space (HEX 20), or other character. 
VmDas ignores some fields when it decodes messages. The fields it reads are explained in 
NMEA Input. 

 

NMEA Input 
The messages VmDas reads are standard GGA, HDG, HDT, VTG messages, and the TRDI proprietary 
PRDID, PASHR, PASHR,ATT, and PASHR,AT2 messages.  

VmDas NMEA data files will contain the TRDI proprietary PADCP message. VmDas generates this mes-
sage and uses it internally. It is expected to be of no use externally, and is not transmitted to other devices. 
It is stored in the *.N1R, *.N2R and *.N3R data files.  

GGA – Global Positioning System Fix Data 
Time, position, and fix related data for a GPS receiver.  
$__GGA,hhmmss.ss,llll.ll,a,yyyy.yy,a,x,xx,x.x,x.x,M,x.x,M,x.x,xxxx*hh<CR><LF> 
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Table 6: GGA NMEA Format 
Field Description 

1* hhmmss.ss UTC of position - 2 fixed digits of hours, 2 fixed digits of minutes, 2 fixed digits of seconds, and a variable number of 
digits for decimal-fraction of seconds. Leading zeros are always included for hours, minutes, and seconds to maintain 
fixed length. The decimal point and associated decimal-fraction are optional if full resolution is not required.  

2* llll.ll Latitude - Two fixed digits of degrees, 2 fixed digits of minutes, and a variable number of digits for decimal-fraction of 
minutes. Leading zeros are always included for degrees and minutes to maintain fixed length of the first 4 chars. The 
decimal point and associated decimal-fraction are optional if full resolution is not required.  

3* a Latitude hemisphere. N or S. 

4* yyyy.yy Longitude - 3 fixed digits of degrees, 2 fixed digits of minutes, and a variable number of digits for decimal-fraction of 
minutes. Leading zeros are always included for degrees and minutes to maintain fixed length of the first 5 chars. The 
decimal point and associated decimal-fraction are optional if full resolution is not required.  

5* a Longitude hemisphere. E or W. 

6* x GPS Quality indicator:   
0 = fix not available or invalid 
1 = GPS fix 
2 = Differential GPS fix  
3 = GPS PPS Mode, fix valid 
4 = Real Time Kinematic. System used in RTK mode with fixed integers 
5 = Float RTK. Satellite system used in RTK mode, floating integers 
6 = Estimated (dead reckoning) mode 
7 = Manual Input Mode 
8 = Simulator mode 
This shall not be a null field. 

7 xx Number of satellites in use, 00 – 12, may be different from the number in view 

8 x.x Horizontal dilution of precision 

9 x.x Antenna altitude above/below mean-sea-level (geoid) 

10 M HEX 4D. Units of antenna altitude, meters 

11 x.x Geoidal separation. The difference between the WGS-84 earth ellipsoid and mean-sea-level (geoid), “-“ = mean-sea-
level below ellipsoid. 

12 M HEX 4D. Units of geoidal separation, meters 

13 x.x Age of Differential GPS data. Time in seconds since last SC104 Type 1 or 9 update, null field when DGPS is not used. 

14 xxxx Differential reference station ID, 0000-1023 

* This field is used by VmDas. 

HDG – Heading, Deviation, and Variation 
Heading (magnetic sensor reading), which if corrected for deviation, will produce Magnetic heading, which if offset 
by variation will provide True heading. 

$__HDG,x.x,x.x,a,x.x,a*hh<CR><LF> 

Table 7: HDG NMEA Format 
Field Description 

1* x.x Magnetic sensor heading, degrees 

2* x.x Magnetic deviation, degrees  

This field and the following direction field are null if deviation is unknown.  

3* a Direction of magnetic deviation. E or W.  

4* x.x Magnetic variation, degrees 

This field and the following direction field are null if variation is unknown. 

5* a Direction of magnetic variation. E or W.  

* This field is used by VmDas. 
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To obtain Magnetic Heading:  

1. Add Easterly deviation (E) to Magnetic Sensor Reading.  

2. Subtract Westerly deviation (W) from Magnetic Sensor Reading. 

To obtain True Heading: 

1. Add Easterly variation (E) to Magnetic Heading. 

2. Subtract Westerly variation (W) from Magnetic Heading. 

HDT – Heading – True 
Actual vessel heading in degrees True produced by any device or system producing true heading.  

$__HDT,x.x,T *hh<CR><LF> 

Table 8: HDT NMEA Format 
Field Description 

1* x.x Heading, degrees True 

2 T HEX 54; T Indicates heading relative to True North 

* This field is used by VmDas. 

 

The first two characters match your device. An example of the HDT string from a Trimble 
device is: $GPHDT,123.456,T*00 

 

VTG – Track Made Good and Ground Speed 
The actual track made good and speed relative to the ground.  

$__VTG,x.x,T,x.x,M,x.x,N,x.x,K,a*hh<CR><LF> 

Table 9: VTG NMEA Format 
Field Description 

1* x.x Track, degrees true 

2 T HEX 54 

3* x.x Track, degrees magnetic 

4 M HEX 4D 

5 x.x Speed, knots 

6 N HEX 4E 

7* x.x Speed, km/hr 

8 K HEX 4B 

9 a Mode indicator 
A=Autonomous mode 
D=Differential mode 
E=Estimated (dead reckoning) mode 
M=Manual input mode 
S=Simulator mode 
N=Data not valid 

This shall not be a null field. 

* This field is used by VmDas. 
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$PASHR - Heading, Pitch, and Roll 
Heading, pitch, and roll from multiple GPS receivers 

$PASHR,hhmmss.ssss,xxx.xx,T,RRR.RR,PPP.PP,HHH.HH,a.aaa,b.bbb,c.ccc,d,e,*hh<CR><LF>  

Table 10: PASHR NMEA Format 
Field Description 

1 hhmmss.ssss UTC time of data 

2* xxx.xx  True vessel heading 0 – 359.99 degrees  

3 T True T 

4* RRR.RR Roll -90.00 to +90.00 degrees, Roll is positive for starboard down 

5* PPP.PP Pitch -90.00 to +90.00 degrees, Pitch is positive for bow up 

6 HHH.HH Heave -99.00 to +99.00 meters 

7 a.aaa Accurracy roll, 0 to 9.999 degrees 

8 b.bbb Accurracy pitch, 0 to 9.999 degrees 

9 c.ccc Accurracy heading, 0 to 9.999 degrees 

10 d  Flag Accur hdg, 0=No aiding, 1=GPS aiding, 2=GPS and GAMS aiding 

11* e Flag: IMU, 0=Satisfactory, 1=IMU out 

* This field is used by VmDas 

 

Ashetec uses PASHQ and PASHR for many purposes. Table 10 is not a complete description of 
the PASHR format; it is a complete description of the PASHR sentences VmDas uses. In 
general, PASHQ is a query to an instrument and PASHR is the reply. VmDas uses only PASHR, 
PASHR,ATT, and PASHR,AT2. It does not use PASHQ sentences. 

 

$PASHR,ATT - Global Positioning System Attitude Data 
Heading, pitch, and roll from multiple GPS receivers 

$PASHR,ATT, ,ssssss.s,hhh.hh,ppp.pp,rrr.rr,mmm.mm,bbb.bb,r<CR><LF> 

Table 11: PASHR,ATT NMEA Format 
Field Description 

1 ATT Identifies this as a PASHR,ATT string 

2 ssssss.s GPS receive time, seconds of week 

3* hhh.hh Heading, degrees 

4* ppp.pp Pitch, degrees, Pitch is positive for bow up 

5* rrr.rr Roll, degrees, Roll is positive for starboard down 

6 mmm.mm  Baseline rms error (BRMS), meters 

7 bbb.bb Measurement rem error (MRMS), meters 

8* r Altitude reset flag, 0=good attitude, 1=bad attitude or rough estimate 

* This field is used by VmDas 
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$PASHR,AT2 - Global Positioning System Attitude Data 
Heading, pitch, and roll from multiple GPS receivers 

$PASHR,AT2,ssssss.s,hhh.hh,ppp.pp,rrr.rr,mmm.mm,bbb.bb,r,l,ddd,P<CR><LF> 

Table 12: PASHR,AT2 NMEA Format 
Field Description 

1 AT2 Identifies this as a PASHR,AT2 string 

2 ssssss.s GPS receive time, seconds of week 

3* hhh.hh Heading, degrees 

4* ppp.pp Pitch, degrees, Pitch is positive for bow up 

5* rrr.rr Roll, degrees, Roll is positive for starboard down 

6 mmm.mm  Baseline rms error (BRMS), meters 

7 bbb.bb Measurement rem error (MRMS), meters 

8* r Altitude reset flag, 0=good attitude, 1=bad attitude or rough estimate 

9 l Last state, 0=No search in progress, >0=Start from last completed state 

10 ddd Each digit is number of double differences for V12, V13, V14 

11 P PDOP 

* This field is used by VmDas 

$PRDID 
TRDI defines a proprietary NMEA message that contains ship heading, pitch, and roll data.  

$PRDID,x.x,x.x,x.x,*hh<CR><LF> 

Table 13: PRDID NMEA Format 
Field Description 

1* x.x Vessel Pitch, degrees. Pitch is positive for bow up 

2* x.x Vessel Roll, degrees. Roll is positive for starboard down  

3* x.x Vessel Heading, degrees True 

* This field is used by VmDas. 

 

$PRDID pitch and roll are not the standard gimbaled pitch and roll. They are simple tilts of the 
mast. In most cases, the difference is small. VmDas ignores the difference. 
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SimRad EM Data Format 
VmDas can decode the SimRad EM data format. The Kongsberg EM Attitude 3000 is a proprietary data-
gram format created by Kongsberg Maritime for use with digital motion sensors. It holds roll, pitch, heave 
and heading information. The datagram contains a 10-byte binary message. For more information, see 
EA640 (kongsberg.online). 

Table 14. SimRad EM Data Format 
Data description Example Format Valid range 

Sync byte 1 / Sensor status [1] 90h to Afh = sensor status 1U 00h, 90h to Afh 

Sync byte 2 Always 90h 1U 144 

Roll LSB [2]   1U   

Roll MSB [2]   1U   

Pitch LSB [2]   1U   

Pitch MSB [2]   1U   

Heave LSB [2]   1U   

Heave MSB [2]   1U   

Heading LSB [2]   1U   

Heading MSB [2]   1U   

Description: 
LSB = least significant byte 
MSB = most significant byte. 

Reading NMEA Data 
NMEA input is required in all moving vessel open ocean data collections. However, VmDas can just col-
lect ensembles from an ADCP. If NMEA data is to be used, options must be set in the communications tab 
to configure the serial ports to read the data (up to three serial ports are available).  

Enabled ports will log all data they receive in an N1R, N2R, or N3R file. Timestamps will be added to syn-
chronize the file with ensembles. 

The user can enable ports so that data is logged with timestamps, and decide independently whether or 
not to save GGA or VTG data in the NAV field. Choose which enabled ports to read the data from on the 
Transform tab. Only enabled ports appear in the drop down lists. 

The user may choose to enable a backup source for GGA or VTG. If you choose both, normally the primary 
source will be put into the NAV field. If the primary data becomes invalid, backup data will be saved in the 
NAV field instead. GGA and VTG are independent choices. Primary and backup for each are independent 
choices.  

 

The GGA - PC clock offset is calculated independently for primary and backup data. If the 
backup GGA data goes into the NAV field, the backup offset goes with it. 

 

VmDas internally generates PADCP messages and adds them to both log files. These messages are ex-
pected to have meaning only to VmDas. 

https://www.kongsberg.online/ea640/ref_en/default.htm?startat=/ea640/ref_en/GUID-E40F7FE9-CA3F-4E6F-98BB-D5370B9FCFE8.html
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Using the Custom NMEA Feature 
Use the custom NMEA feature to create custom decoder files for NMEA heading, pitch, and roll (HPR) 
data. This feature is available in VmDas 1.46.6 and higher.  

When you install VmDas, the installation copies the following example files to the same location as the 
command files and all other files: C:\Program Files\RD Instruments\VmDas  

• CustomNmea.txt file for the Septentrio NMEA data string $PSSN  

• Septentrio NMEA Attitude_sample3.txt example NMEA data file  

• Septentrio NMEA Data File Format.pdf explains the Septentrio data format 

Setup 
The following explains how to use the custom decoder files for NMEA HPR data.  

 

In order for the Custom NMEA feature to work, the heading, pitch, and roll all must be 
decimal degrees (i.e. XXX.XX). For the pitch and roll to work, they must be within ±180 
degrees AND positive pitch when the bow is higher than the stern and positive roll when the 
port is higher than the starboard. 

 

1. Copy the text file CustomNmea.txt to a folder of your choice.  

2. Inside the text file just copied, add the decoder sequence for the NMEA data you are using. For ex-
ample, the Septentrio NMEA data string is shown below: 

$PSSN,HRP,160059.00,170610,283.480,41.693,1.852,0.006,0.007,0.011,06,4,2.0,E*34  
 

 The Custom NMEA decoder string for the above data string appears below: 
$PSSN,,,,H,R,P,,,,,,, 
 

• The first field in the decoder file is the NMEA header for the data string “$PSSN,”. Note the 
comma is included. 

• Following the NMEA header, enter a comma for each field that you are going to skip. In this ex-
ample the first three fields following the $PSSN are skipped (HRP,160059.00,170610,) and the 
last six fields are skipped. 

• Enter an H, P, or R for the field that corresponds to the heading, pitch, or roll data. In this exam-
ple, the data is organized by Heading, Roll, and Pitch. 

3. Start VmDas and open the Program Options Transform tab. To get to the Program Options 
Transform tab:  

1. Click the File menu. 

2. Click Collect. 

3. Click Options. 

4. Click Edit Data Options. 

5. Click the Transform tab. 

4. Click the drop down menu for the Heading Source and/or Tilt Source and select CUSTOM 
(see the green circles on Figure 38). 

5. Set the path for the CustomNmea.txt file you created in Step “a” (shown in the red circle on Figure 
38). 
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Figure 38. Using the Custom NMEA Feature 
 



 

VmDas Software User’s Guide P/N 95A-6015-00 (January 2024) 

 

 
EAR99 Technology Subject to Restrictions Contained on the Cover Page. Page 101 

 

NMEA Output 

$VDDBT – Depth Below Transducer 
Water depth referenced to the transducer 

$VDDBT,x.x,f,x.x,M,x.x,F*hh<CR><LF> 

Table 15: VDDBT NMEA Format 
Field Description 

1 x.x Water depth, feet 

2 f HEX 66 

3 x.x Water depth, Meters 

4 M HEX 4D 

5 x.x Water depth, Fathoms 

6 F HEX 46 

 

$VDHDT – Heading – True 
Actual vessel heading in degrees True. 

$VDHDT,x.x,T*hh<CR><LF> 

Table 16: VDHDT NMEA Format 
Field Description 

1 x.x Heading, degrees True. 

2 T HEX 54 

 

$VDVBW – Dual Ground/Water Speed 
Water referenced and ground referenced speed data. 

$VDVBW,x.x,x.x,A,x.x,x.x,A*hh<CR><LF> 

Table 17: VDVBW NMEA Format 
Field Description 

1 x.x Longitudinal water speed, knots. “-“ = astern. 

2 x.x Transverse water speed, knots. “-“ = port. 

3 A Status: water speed, A = Data valid, V = Data invalid. 

4 x.x Longitudinal ground speed, knots. “-“ = astern. 

5 x.x Transverse ground speed, knots. “-“ = port. 

6 A Status: ground speed, A = Data valid, V = Data invalid. 
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$VDZDA – Time and Date 
UTC, day, month, year, and local time zone.  

$VDZDA,hhmmss.ss,xx,xx,xxxx,xx,xx*hh<CR><LF> 

Table 18: VDZDA NMEA Format 
Field Description 

1 hhmmss.ss UTC 

2 xx Day, 01 – 31. 

3 xx Month, 01 – 12. 

4 xxxx Year 

5 xx Local time zone description. –13 to 13 hours.  

The number of whole hours added to local time to obtain GMT. Zone description is negative for East longi-
tudes.  

6 xx Local time zone minutes description. –59 to 59 minutes. 

The number of whole minutes added to local time to obtain GMT. This permits a finer resolution time zone 
description than is possible using hours alone. The sign is the same as the hour time zone description. 

VmDas produces a null field here.  

 

Writing NMEA Data 
VmDas writes strings formatted as described in the NMEA 0183 standard to a serial port, a TCP/IP port, 
or both.  

 

This is not in keeping with NMEA standards. The NMEA 0183 standard specifies strings are to 
be transmitted through a serial port. The NMEA 2000 standard is being developed for 
transmitting similar data over a network. VmDas does not support the NMEA 2000 standard. 
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Internal NMEA Messages 
TRDI defines a proprietary NMEA message for VmDas internal use only that contains VmDas internal 
timing information. 

$PADCP 
This message is stored in the VmDas N1R, N2R and N3R extension data files as a time stamp. The 
$PADCP is generated by VmDas.  

$PADCP, ens,yyyy,xx,xx,xx,xx,ss.ss,x.x*hh<CR><LF> 

Table 19: PADCP NMEA Format 
Field Description 

1 ens Ensemble number. A variable length integer numeric field without leading zeros. 

2 yyyy Year, 4 digits, PC local time. 

3 xx Month, 01 – 12, PC local time. 

4 xx Day, 01 – 31, PC local time. 

5 xx Hours, 00 – 23, PC local time. 

6 xx Minutes, 00 – 59, PC local time. 

7 ss.ss Seconds and hundredths, 00.00 – 59.99, PC local time. 

8 x.x PC clock offset from UTC in seconds. –86399.99 to 86399.99.  

VmDas keeps track of the date/time of GGA messages by recording the date/time according to the PC clock when 
the message is read, and calculating the offset between the times in the PC clock and the GGA message. If the clock 
offset is added to a GGA message time, the result is a local PC time, The offset corrects for the difference in time 
zone between local PC time and GGA time (UTC) and any errors because the two clocks are not perfectly synchro-
nized. 

If no GGA messages have been read, this field is null.  

 

 

This message is used to synchronize ensemble data and NMEA data. 
The year, month, day, hour, minute, and second fields describe the time that a ping 
command was sent to the ADCP. 
The ens field contains the number of the ensemble generated by the ping command. 

 

Further Information About NMEA Strings 
Users who need full details about NMEA data strings can find more information in the NMEA 0183 stand-
ard, available from the National Marine Electronics Association at.  

P O Box 3435  
New Bern, NC  
28564-3435 

252-638-2626 (voice) 
252-638-4885 (fax) 

nmea@coastalnet.com (e-mail)  
http://www.nmea.org/ (web site) 

 

  

mailto:nmea@coastalnet.com
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NOTES 
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CH A P T E R  7  –  VM DA S  OU T P U T S  

 
 

Chapter 7 

VMDAS OUTPUTS 

 

 

In this chapter:  

• Ensemble Output Data 

• Speed Log Output Data 

• Ensemble Output (ASCII) Data 
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VmDas can output Ensemble, Speed Log, and ASCII data out the serial port or through an Ethernet port.  

Ensemble Output Data 
Long term averaged ensemble data is output in the TRDI standard binary ensemble (PD0) output format. 

1. On the File menu, click Collect Data. 

2. On the Options menu, click Edit Data Options. If you have created a User Option File, click 
Load. 

3. On the Communications tab, select the Ensemble Output (Binary LTA) button.  

4. To output the data to a serial port, click the Enable Serial box, and configure the serial port pa-
rameters, then click the Set button to apply the new configuration. Verify that the new settings ap-
pear in the Current Settings section. 

5. To output the data to a network port, click the Enable Network box, and set the Local IP Port 
number. VmDas will be the server, and the local machine's IP address will be used automatically. 
After data collection has started, a remote client can request a TCP/IP connection using the speci-
fied port number and the IP address of the computer running VmDas to receive the data. 

Speed Log Output Data 
Speed log data output consists of the NMEA VBW and DBT messages, and is calculated from the short-
term averaged data. Use the following procedure to enable speed log data output. 

 

Speed log data is not stored to a disk file. It is only sent to a serial port and/or an Ethernet 
port. 

 

6. On the File menu, click Collect Data. 

7. If you have created a User Option File, on the Options menu, click Load. Choose your file and 
click OK.  

8. On the Options menu, click Edit Data Options.  

9. On the Communications tab, select the Speed Log Output button.  

10. To output the data to a serial port, click the Enable Serial box, and configure the serial port pa-
rameters, then click the Set button to apply the new configuration. Verify that the new settings ap-
pear in the Current Settings section.  

11. To output the data to a network port, first choose an IP port number. VmDas uses 5434 by default, 
which should be fine for most users. Remote clients will need to know the IP port number and the 
IP address of the computer running VmDas to receive data.  

 Click the Enable Network box, and set the Local IP Port number. VmDas will use the local ma-
chine's IP address automatically. Click the Set button to apply the new configuration. Verify that 
the new settings appear in the Current Settings section.  

 After data collection has started, a remote client can request a TCP/IP connection using the specified 
port number and the IP address of the computer running VmDas to receive the data. 

Tips for Advanced Users 

Advanced users can get more control over the Speed Log data by using the following tips. 

Speed Log data will only be output if the serial and/or Ethernet port(s) are configured for that purpose.  
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• If a port is configured for speed log output, speed log output will be produced. If there is no data 
or the data is invalid, the NMEA messages will indicate that they contain invalid data. 

The data will only be received if something is listening to the port(s). This requires a cable and usually a 
second computer. 

• One device may listen to a serial port. When sending speed log data out an Ethernet port, VmDas 
is a TCP/IP server and supports up to 100 clients. 

Speed log data is calculated from ensembles in the short-term averaged data. There will be one VBW and 
one DBT message for each short-term average ensemble. 

• To control the time between messages, on the Options menu, click Edit Data Options, choose 
the Averaging tab, and change the First Time Interval. 

The speed log will contain valid data only if the ADCP is configured to produce the data. The data comes 
from the bottom track field in the short-term average data. 

• The VBW message will contain water speed data only if the ADCP has been configured to produce 
water reference layer data. The BK and BL commands are useful here. 

• The VBW message will contain bottom speed data only if the ADCP has been configured to pro-
duce bottom velocity data. The BP command is useful here. 

• The DBT message will contain depth data only if the ADCP has been configured to produce bot-
tom track range data. This data is present whenever bottom track data is being produced, and the 
bottom is in range. The BP and BX commands are useful here. 

• The Options on the ADCP Setup tab can override the BP and BX commands in a command file. To 
use the ADCP defaults for these commands or to set them from a command file, the Set BT 
On/Off box must be unchecked. 

Ensemble Output (ASCII) Data 
ASCII-out files contain a fixed format of text. You can then use these files in other programs (spread-
sheets, databases, and word processors). 

1. On the File menu, click Collect Data. 

2. On the Options menu, click Edit Data Options. If you have created a User Option File, click 
Load. 

3. On the Communications tab, select the Ensemble Output (ASCII) button.  

4. To output the data to a serial port, click the Enable Serial box, and configure the serial port pa-
rameters, then click the Set button to apply the new configuration. Verify that the new settings ap-
pear in the Current Settings section. 

5. To output the data to a network port, click the Enable Network box, and set the Local IP Port 
number. VmDas will be the server, and the local machine's IP address will be used automatically. 
After data collection has started, a remote client can request a TCP/IP connection using the speci-
fied port number and the IP address of the computer running VmDas to receive the data. 

6. In the Set Ensemble Output Configuration Here section, check the box for each type of data 
within the ensemble that you want output. In the Data Select box, select the desired data source. 
In the Velocity Ref box, select the desired reference velocity to be applied to the profile data. In 
the Output column, select the desired depth cell range to output by setting the Start Bin and 
End Bin. If Water Current Profile Layer is selected as the velocity reference, then in the Pro-
file Layer column, select the desired depth cell range to use as the reference velocity by setting 
the Start Bin and End Bin. 
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ASCII Ensemble Output Format 
This section explains the format of the data sent from the ADCP to the ensemble-out serial device after 
each ADCP ensemble. Sending ensemble-out data is an option in the Options, Program Options, 
Communications Setup menu. You set the communications protocol and select the data to send to the 
ensemble-out device through the Communication options. Ensemble-out data are in ASCII with fixed 
field lengths. 

The transmission of ensemble-out data occurs after VmDas finishes recording ADCP data after each 
ADCP ensemble. The next section shows a sample ensemble-out data transmission. The first byte in the 
ensemble-out data stream is a START OF TEXT (^B) byte. This byte is also known as STX, ASCII charac-
ter 2, or Control-B (^B). VmDas always sends the STX byte when data transmission begins. After the STX 
byte, VmDas sends a 2-byte flag that represents the data type that will be sent next. See Ensemble-Out Data 
Format Description for an explanation of all the flags and associated fields used in the ensemble-out data 
stream. 

Sample Ensemble-Out Data Transmission 
^B 0     96 91 10  2  9 54 30<CR/LF> 
 1   4   4   1   4     0     0     0     0<CR/LF> 
       6   -1375     -38      33<CR/LF> 
     -23   -1453      -2      -3<CR/LF> 
      85   -1465     -44     -52<CR/LF> 
      49   -1464     -76      30<CR/LF> 
 2   4 4   1   4<CR/LF> 
     128     119     133     142<CR/LF> 
     129     103     120     110<CR/LF> 
     117     133     141     142<CR/LF> 
 
     134     141     134     127<CR/LF> 
 3   4 4   1   4<CR/LF> 
     167     155     159     168<CR/LF> 
     162     151     149     161<CR/LF> 
     154     145     137     154<CR/LF> 
     146     138     130     152<CR/LF> 
 4   4 4   1   4<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
 
 5   4 4   1   4<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 6  0  0  0  10  100  25  25  2  0  0  0  0  5000  25  0  0  0  2500  0  0  0  35  1480<CR/LF> 
 7  2  4<CR/LF> 
     -33   -1414     -62  -32768<CR/LF> 
     833     878       0     783<CR/LF> 
 8  13856000 -324937000    634   4786    425    470<CR/LF> 
 
^C^B 0     97 91 10  2  9 55 00<CR/LF> 
 1   4   4   1   4     0     0     0     0<CR/LF> 
       7   -1373     -40      29<CR/LF> 
     -19   -1456      -1      -4<CR/LF> 
      89   -1462     -46     -51<CR/LF> 
      48   -1466     -73      34<CR/LF> 
 2   4 4   1   4<CR/LF> 
     121     123     130     139<CR/LF> 
     127     100     122     114<CR/LF> 
     130     135     140     141<CR/LF> 
 
     130     140     138     129<CR/LF> 
 3   4 4   1   4<CR/LF> 
     167     156     153     166<CR/LF> 
     163     155     147     162<CR/LF> 
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     156     143     138     153<CR/LF> 
     147     140     132     151<CR/LF> 
 4   4 4   1   4<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
 
 5   4 4   1   4<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 6  0  0  0  10  100  25  25  2  0  0  0  0  5000  25  0  0  0  2500  0  0  0  35  1480<CR/LF> 
 7  2  4<CR/LF> 
     -31   -1420     -58    -768<CR/LF> 
     840     862     845     850<CR/LF> 
 8  13857000 -324938000    634   4787    426    471<CR/LF> 
 
^C 

Ensemble-Out Data Format Description 
Each ASCII ensemble-out data stream begins with a Start Of Text code <^B> and ends with an End Of 
Text code <^C>. VmDas identifies each data type with an integer flag. At least one space separates the 
fields within each data type. Each line of data ends with a carriage return <CR> and line feed <LF> se-
quence.  

Table 20: Ensemble-Out Data Format 

Flag Field Description 

0 1 Flag 0 identifies the ensemble number just processed by the ADCP and the date/time that data collection for the 
ensemble began. The fields identified by this flag contain: 

 2 The ensemble number just processed by the ADCP. 

 3 The year data collection began for this ensemble. 

 4 The month data collection began for this ensemble. 

 5 The day data collection began for this ensemble. 

 6 The hour data collection began for this ensemble. 

 7 The minute data collection began for this ensemble. 

 8 The second data collection began for this ensemble. 

1 1 Flag 1 marks the start of velocity data. VmDas scales the water current velocity data in millimeters per second 
(mm/s). A value of -32768 indicates bad or missing data. VmDas lists water profile velocity data in columns begin-
ning with the next output line. The fields identified by this flag contain: 

 2 The number of bins selected for transmission.  

 3 The number of beams used by the ADCP to collect the data. This value corresponds to the number of COLUMNS of 
data beginning with the next output line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 The east(+)/west(-) water-current velocity of the reference layer if VELOCITY REF is set to BOTTOM or MEAN (Com-
munication options). 

 7 The north(+)/south(-) water-current velocity of the reference layer if VELOCITY REF is set to BOTTOM or MEAN 
(Communication options). 
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Table 20: Ensemble-Out Data Format 

Flag Field Description 

 8 The up(+)/down(-) water-current velocity of the reference layer if VELOCITY REF is set to BOTTOM or MEAN (Com-
munication options). 

 9 The error velocity of the reference layer if VELOCITY REF is set to BOTTOM or MEAN (Communication options). 

 10 Column data for the east(+)/west(-) water-current velocities for the bin range selected in the Communication op-
tions. 

 11 Column data for the north(+)/south(-) water-current velocities for the bin range selected in the Communication op-
tions. 

 12 Column data for the up(+)/down(-) water-current velocities for the bin range selected in the Communication op-
tions. 

 13 Column data for the error velocities for the bin range selected in the Communication options. 

2 1 Flag 2 marks the start of correlation magnitude data. A value of -32768 indicates missing data. VmDas lists correla-
tion data in columns beginning with the next output line. The fields identified by this flag contain: 

 2 The number of bins selected for transmission.  

 3 The number of beams used by the ADCP to collect the data. This value corresponds to the number of COLUMNS of 
data beginning with the next output line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 Column data for the Beam #1 correlation data for the bin range selected in the Communication options. 

 7 Column data for the Beam #2 correlation data for the bin range selected in the Communication options. 

 8 Column data for the Beam #3 correlation data for the bin range selected in the Communication options. 

 9 Column data for the Beam #4 correlation data for the bin range selected in the Communication options. 

3 1 Flag 3 marks the start of echo intensity data. VmDas scales echo intensity data in ADCP counts. A value of -32768 
indicates missing data. VmDas lists echo intensity data in columns beginning with the next output line. The fields 
identified by this flag contain: 

 2 The number of bins selected for transmission.  

 3 The number of beams used by the ADCP to collect the data. This value corresponds to the number of COLUMNS of 
data beginning with the next output line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 Column data for the Beam #1 echo intensity data for the bin range selected in the Communication options. 

 7 Column data for the Beam #2 echo intensity data for the bin range selected in the Communication options. 

 8 Column data for the Beam #3 echo intensity data for the bin range selected in the Communication options. 

 9 Column data for the Beam #4 echo intensity data for the bin range selected in the Communication options. 

4 1 Flag 4 marks the start of percent-good data. VmDas scales percent-good data in percentage points (0-99). A value of 
-32768 indicates bad or missing data. VmDas lists percent-good data in columns beginning with the next output line. 
The fields identified by this flag contain: 

 2 The number of bins selected for transmission.  

 3 The number of beams used by the ADCP to collect the data. This value corresponds to the number of COLUMNS of 
data beginning with the next output line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 Column data for the Beam #1 percent-good data for the bin range selected in the Communication options. 

 7 Column data for the Beam #2 percent-good data for the bin range selected in the Communication options. 
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Table 20: Ensemble-Out Data Format 

Flag Field Description 

 8 Column data for the Beam #3 percent-good data for the bin range selected in the Communication options. 

 9 Column data for the Beam #4 percent-good data for the bin range selected in the Communication options. 

5 1 Flag 5 marks the start of status data. See VmDas STA and LTA Output Data Format for information on how status 
data are scaled. A value of -32768 indicates bad or missing data. VmDas lists status data in columns beginning with 
the next output line. The fields identified by this flag contain: 

 2 The number of bins selected for transmission.  

 3 The number of beams used by the ADCP to collect the data. This value corresponds to the number of COLUMNS of 
data beginning with the next output line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 Column data for the Beam #1 status data for the bin range selected in the Communication options. 

 7 Column data for the Beam #2 status data for the bin range selected in the Communication options. 

 8 Column data for the Beam #3 status data for the bin range selected in the Communication options. 

 9 Column data for the Beam #4 status data for the bin range selected in the Communication options. 

6 1 Flag 6 marks the start of leader data. The fields identified by this flag contain: 

 2 The minutes portion of the time between pings as set by the TP-command. 

 3 The seconds portion of the time between pings as set by the TP-command. 

 4 The hundredths of seconds portion of the time between pings as set by the TP-command. 

 5 The number of pings per ensemble as set by the WP-command. 

 6 The number of depth cells (bins) as set by the WN-command. 

 7 The depth cell (bin) length in centimeters as set by the WS-command. 

 8 The blank after transmit in centimeters as set by the WF-command. 

 9 The ADCP profiling mode as set by the WM-command. 

 10 The Built-In Test result code from the last ADCP ensemble. 

 11 The sensor source as set by the EZ-command. 

 12 The available sensors as read by the PS1-command. 

 13 The low correlation threshold as set by the WC-command. 

 14 The error velocity threshold in mm/s as set by the WE-command. 

 15 The percent-good minimum as set by the WG-command. 

 16 The average ADCP pitch (tilt 1, x-axis) angle in hundredths of degrees (e.g., -70 = -0.7°) during the ADCP data ensem-
ble. This value comes from the internal pendulums or external gyrocompass. 

 17 The average ADCP roll (tilt 2, y-axis) angle in hundredths of degrees (e.g., 430 = 4.3°) during the ADCP data ensem-
ble. This value comes from the internal pendulums or external gyrocompass. 

 18 The average ADCP heading angle in hundredths of degrees (e.g., 7707 = 77.07°) during the ADCP data ensemble. This 
value comes from the internal flux-gate compass or external gyrocompass. 

 19 The average water temperature in hundredths of degrees C (e.g., 1711 = 17.11°C) at the transducer head during the 
ADCP data ensemble. 

 20 The standard deviation (accuracy) of heading data in degrees during the ADCP data ensemble from the compass. 

 21 The standard deviation (accuracy) of pitch (tilt 1, x-axis) data in tenths of degrees (e.g., 15 = 1.5°) during the ADCP 
data ensemble from the pendulum/gyrocompass. 

 22 The standard deviation (accuracy) of roll (tilt 2, y-axis) data in tenths of degrees (e.g., 5 = 0.5°) during the ADCP data 
ensemble from the pendulum/gyrocompass. 
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Table 20: Ensemble-Out Data Format 

Flag Field Description 

 23 The salinity value in parts per thousand from the ADCP (ES or EZ-command). 

 24 The speed of sound value in m/s from the ADCP (EC or EZ-command). 

7 1 Flag 7 marks the start of bottom-track data. A value of -32768 indicates bad or missing velocity data. A zero indicates 
bad or missing beam range data. The fields identified by this flag contain: 

 2 The number of lines of bottom-track data sent. This value corresponds to the number of ROWS of data beginning 
with the next output line. 

 3 The number of beams used by the ADCP to collect the bottom-track data. This value corresponds to the number of 
COLUMNS of data beginning with the next output line. 

 4 The east(+)/west(-) bottom-track velocity in mm/s. 

 5 The north(+)/south(-) bottom-track velocity in mm/s. 

 6 The up(+)/down(-) bottom-track velocity in mm/s. 

 7 The bottom-track error velocity in mm/s. 

 8 The Beam #1 range in meters to the bottom/surface, excluding ADCP depth. 

 9 The Beam #2 range in meters to the bottom/surface, excluding ADCP depth. 

 10 The Beam #3 range in meters to the bottom/surface, excluding ADCP depth. 

 11 The Beam #4 range in meters to the bottom/surface, excluding ADCP depth. 

8 1 Flag 8 marks the start of external navigation data collected by VmDas. A value of 2147483647 indicates bad or miss-
ing latitude/longitude data. A value of -32768 indicates bad or missing data for all other fields. The fields identified 
by this flag contain: 

 2 Navigation device latitude in thousandths of seconds. 

 3 Navigation device longitude in thousandths of seconds (-324937000 = W90°15'37"). 

 4 Navigation device speed in mm/s. 

 5 Navigation device course in hundredths of degrees (4786 = 47.86°). 

 6 The east(+)/west(-) navigation device velocity in mm/s. 

 7 The north(+)/south(-) navigation device velocity in mm/s. 
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CH A P T E R  8  –  ADCP O U T P U T  DA T A  FO R M A T  A N D  VM DA S  

 
 

 

 

 

 

 

 

 

 

 

 

 

Chapter 8 

ADCP OUTPUT DATA FORMAT 

 

 

In this chapter:  

• Binary Navigation Data Format 
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This section shows the format of the VmDas Navigation data when using an ADCP. This output can only 
be binary.  

The ADCP binary output data buffer contains header data, leader data, velocity, correlation magnitude, 
echo intensity, percent good, and a checksum. The ADCP collects all data in the output buffer during an 
ensemble. The VmDas program writes this ADCP output into the *.ENR files (see File Naming Conventions). 
The *.ENR file format is described in the ADCP Technical Manual, Commands and Output Data Format 
guide.  

The Navigation data is inserted before the checksum (and reserved bytes) when VmDas saves the ENS, 
ENX, STA and LTA files. Figure 39 show the sequence in which the VmDas program creates the ENS, 
ENX, STA and LTA files that make up the binary output buffer. Figure 40 shows the format of the binary 
Navigation Data. Table 21 lists the format, bytes, fields, scaling factors, and a detailed description of every 
item in the binary navigation output buffer. 

Always Output 
HEADER 

FIXED LEADER DATA  
VARIABLE LEADER DATA 

WD-command  
WP-command 

VELOCITY 
CORRELATION MAGNITUDE 

ECHO INTENSITY 
PERCENT GOOD 

BP-command BOTTOM TRACK DATA 

See Binary Navigation Data Format NAVIGATION DATA (92 BYTES) 

Always Output RESERVED 
CHECKSUM 

Figure 39. ENS, ENX, STA and LTA Binary Output Data Format 

 

For a full description of the Binary Output Data Format (i.e. Header, Fixed Leader Data, etc.), 
see the ADCP Technical Manual Commands and Output Data Format guide. This guide is also 
available in Adobe Acrobat Reader pdf format on TRDI’s website and on the documentation 
CD sent with your system. 
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Binary Navigation Data Format 
Figure 40. Binary Navigation Data Format 

 BIT POSITIONS  

BYTE 7 6 5 4 3 2 1 0  

1 NAVIGATION ID LSB 00h 

2  MSB 20h 

3 UTC DAY  

4 UTC MONTH  

5 
UTC YEAR 

LSB 

6 MSB 

7 

UTC TIME OF FIRST FIX 

LSB 

8  

9  

10 MSB 

11 

PC CLOCK OFFSET FROM UTC 

LSB 

12  

13  

14 MSB 

15 

FIRST LATITUDE 

LSB 

16  

17  

18 MSB 

19 

FIRST LONGITUDE 

LSB 

20  

21  

22 MSB 

23 

UTC TIME OF LAST FIX 

LSB 

24  

25  

26 MSB 

27 

LAST LATITUDE 

LSB 

28 MSB 

29 LSB 

30 MSB 

31 

LAST LONGITUDE 

LSB 

32 MSB 

33 LSB 

34 MSB 

35 
AVG SPEED 

LSB 

36 MSB 



 

P/N 95A-6015-00 (January 2024) VmDas Software User’s Guide 

 

Page 116 EAR99 Technology Subject to Restrictions Contained on the Cover Page.  
 

Figure 40. Binary Navigation Data Format 
 BIT POSITIONS  

BYTE 7 6 5 4 3 2 1 0  

37 
AVG TRACK TRUE 

LSB 

38 MSB 

39 
AVG TRACK MAGNETIC 

LSB 

40 MSB 

41 
SPEED MADE GOOD 

LSB 

42 MSB 

43 
DIRECTION MADE GOOD 

LSB 

44 MSB 

45 
RESERVED 

 

46  

47 
FLAGS 

 

48  

49 
RESERVED 

 

50  

51 

ADCP ENSEMBLE NUMBER 

LSB 

52  

53  

54 MSB 

55 
ADCP ENSEMBLE YEAR 

LSB 

56 MSB 

57 ADCP ENSEMBLE DAY  

58 ADCP ENSEMBLE MONTH  

59 

ADCP ENSEMBLE TIME 

 

60  

61  

62  

63 
PITCH 

LSB 

64 MSB 

65 
ROLL 

LSB 

66 MSB 

67 
HEADING 

LSB 

68 MSB 

69 
NUMBER OF SPEED AVG 

LSB 

70 MSB 

71 NUMBER OF TRUE TRACK AVG LSB 



 

VmDas Software User’s Guide P/N 95A-6015-00 (January 2024) 

 

 
EAR99 Technology Subject to Restrictions Contained on the Cover Page. Page 117 

 

Figure 40. Binary Navigation Data Format 
 BIT POSITIONS  

BYTE 7 6 5 4 3 2 1 0  

72 MSB 

73 
NUMBER OF MAG TRACK AVG 

LSB 

74 MSB 

75 
NUMBER OF HEADING AVG 

LSB 

76 MSB 

77 
NUMBER OF PITCH/ROLL AVG 

LSB 

78 MSB 

79 
AVERAGE TRUE VELOCITY NORTH 

LSB 

80 MSB 

81 
AVERAGE TRUE VELOCITY EAST 

LSB 

82 MSB 

83 
AVERAGE MAGNETIC VELOCITY NORTH 

LSB 

84 MSB 

85 
AVERAGE MAGNETIC VELOCITY EAST 

LSB 

86 MSB 

87 
SPEED MADE GOOD NORTH 

LSB 

88 MSB 

89 
SPEED MADE GOOD EAST 

LSB 

90 MSB 

91 
PRIMARY FLAGS 

LSB 

92 MSB 

See Table 21 for description of fields 

 

This data is output in this format only by the VmDas program in the ENS, ENX, STA and LTA 
data files. 
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Navigation Data Format – Detailed Explanation 
These fields contain the Navigation Data. This data is only recorded in the ENS, ENX, STA, and LTA files 
created by the TRDI Windows software program VmDas. The LSB is always sent first. The ADCP Tech-
nical Manual has descriptions of commands used to set these values. 

Table 21: Binary Navigation Data Format 

Hex Digit Binary 
Byte 

Field Description 

1-4 1,2 ID Code Stores the sum of velocities identification word (2000h). 

5-6 3 UTC Day This field contains the UTC Day.  

7-8 4 UTC Month This field contains the UTC Month. 

9-12 5,6 UTC Year This field contains the UTC Year, i.e. i.e. 07CF = 1999 

13-20 7-10 UTC Time of first fix UTC time since midnight; LSB = 1E-4 seconds 

21-28 11-14 PC Clock offset 
from UTC 

PC Time – UTC (signed); LSB = milliseconds 

29-36 15-18 First Latitude This is the first latitude position received after the previous ADCP ping.  

LSB = approx. 8E-8 deg (32-bit BAM) 

In the BAM (Binary Angular Measure) format, the most significant bit of the word has 
a weight of 180 degrees, and you keep dividing by 2 as you proceed to the right. The 
lease significant bit for a 32-bit BAM is about 8E-8 arc degrees (180/231), or just under 
1 cm of longitudinal distance at the equator, where 1 arc minute = 1 Nautical mile. If 
you interpret the BAM word as an unsigned number, the range is 0 to (360-LSB) de-
grees, and if you interpret the BAM as a signed number, the range is –180 to 180-LSB) 
degrees. The least significant bit for a 16-bit BAM is about 0.0055 degrees (180/215). 
Some 32-bit BAM examples are: 

UNSIGNED 

0x40000000   90 degrees 

0x80000000  180 degrees       

0xC0000000  270 degrees       

0xFFFFFFFF  360 degrees minus one LSB degrees 

SIGNED 

0x40000000   90 degrees 

0x80000000  minus 180 degrees 

0xC0000000  minus 90 degrees 

0xFFFFFFFF  minus one LSB degrees 

37-44 19-22 First Longitude This is the first longitude position received after the previous ADCP ping. 

LSB = approx. 8E-8 deg (32-bit BAM) 

45-52 23-26 UTC Time of last fix Time since midnight UTC; LSB = 1E-4 seconds 

53-60 27-30 Last Latitude This is the last latitude position received prior to the current ADCP ping. 

LSB = approx. 8E-8 deg (32-bit BAM) 

61-68 31-34 Last Longitude This is the last longitude position received prior to the current ADCP ping. 

LSB = approx. 8E-8 deg (32-bit BAM) 

69-72 35,36 Avg Speed Average Navigational Speed mm/sec (signed) 

73-76 37,38 Avg Track True Average True Navigational Ship Track Direction 

LSB = approx. 0.0055 deg (16-bit BAM) 

77-80 39,40 Avg Track Magnetic Average Magnetic Navigational Ship Track Direction 

LSB = approx. 0.0055 deg (16-bit BAM) 
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Table 21: Binary Navigation Data Format 

Hex Digit Binary 
Byte 

Field Description 

81-84 41,42 Speed Made Good 
(SMG) 

Speed calculated between navigation positions. LSB = one mm/sec (signed) 

The Speed Made Good (SMG) and Direction Made Good (DMG) quantities are calcu-
lated from the navigation fixes that enter the system between ADCP outputs, and are 
calculated as follows: 

IF: 

aLat(i) = the average of the latitudes of the nav fixes in interval I 
aLon(i) = the average of the longitudes of the nav fixes in interval I 
Ta(i) = the average of the time of validity of the nav fixes in interval I 
dLat = the difference in average latitude between averaging intervals 
dLon = the difference in average longitude between averaging intervals 
VelMGn (i) = the velocity made good in the East direction for interval I 
VelMGn (i) = the velocity made good in the East direction for interval I 
LatToDist (dLat) is a function that converts delta Latitude to a distance 
LonToDist (dLon) is a function that converts delta Longitude to a distance 
Smg (i) = speed made good in interval i 
Dmg (i) = direction made good in interval i 
 

THEN: 

dLat = (aLat (I-1) – aLat (i))  
dLon = (aLon (i-1) – aLon (i))  
VelMgn (i) = LatToDist (dLat) / (Ta(i-1) – Ta(i))  
VelMge (i) = LonToDist (dLon) / (Ta(i-1) – Ta(i))  
Smg(i) = sqrt(VelMgn(i)2 + VelMGe(i)2)  
Dmg(i) = atan(VelMge(i) / VelMGn(i))  

85-88 43,44 Direction Made 
Good (DMG) 

Direction calculated between navigation positions. LSB-= approx. 0.0055 deg (16-bit 
BAM) 

89-92 45,46 Reserved Reserved for TRDI use. 

93-96 47,48 Flags Describes the validity of the data. Each bit has represents a separate flag and has its 
own meaning 1=true, 0=false. The flag bits are defined as follows: 
bit 0 = Data updated  
bit 1 = PSN Valid  
bit 2 = Speed Valid  
bit 3 = Mag Track Valid  
bit 4 = True Track Valid  
bit 5 = Date/Time Valid  
bit 6 = SMG/DMG Valid  
bit 7 = Pitch/Roll Valid  
bit 8 = Heading Valid  
bit 9 = ADCP Time Valid  
bit 10 = Clock Offset Valid  
bit 11 = Avg True Velocity North & East Valid 
bit 12 = Avg Mag Velocity North & East Valid 
bit 13 = Velocity Made Good North & East Valid 
bit 14 = Reserved 
bit 15 = Reserved 

97-100 49,50 Reserved Reserved for TRDI use. 

101-108 51-54 ADCP Ensemble 
Number 

This field contains the sequential number of the ensemble to which the data in the 
output buffer apply. 

Scaling:  LSD = 1 ensemble; Range = 1 to 4,294,967,296 ensembles 

109-112 55,56 ADCP Ensemble 
Year 

This field contains the ADCP year, i.e. 07CFH = 1999 

113-114 57 ADCP Ensemble 
Day 

This field contains the ADCP day. 

115-116 58 ADCP Ensemble 
Day 

This field contains the ADCP month. 
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Table 21: Binary Navigation Data Format 

Hex Digit Binary 
Byte 

Field Description 

117-124 59-62 ADCP Ensemble 
Time 

Number of seconds since midnight; LSB=1E-4 seconds 

125-128 63,64 Pitch Pitch angle. LSB- = approx. 0.0055 deg (16-bit BAM) 

Pitch is positive when bow is higher than stern. 

129-132 65,66 Roll Roll angle. LSB- = approx. 0.0055 deg (16-bit BAM) 

Roll is positive when the port side is higher than the starboard side. 

133-136 67,68 Heading Heading input. LSB- = approx. 0.0055 deg (16-bit BAM) 

137-140 69,70 Number of Speed 
Samples Averaged 

The number of speed samples averaged since the previous ADCP ping. 

141-144 71,72 Number of True 
Track Samples Avg 

The number of True Track samples averaged since the previous ADCP ping. 

145-148 73,74 Number of Mag-
netic Track Samples 
Avg 

The number of Magnetic Track samples averaged since the previous ADCP ping. 

140-152 75,76 Number of Heading 
Samples Averaged 

The number of Heading samples averaged since the previous ADCP ping. 

153-156 77,78 Number of 
Pitch/Roll Samples 
Averaged 

The number of Pitch/Roll samples averaged since the previous ADCP ping. 

157-169 79,80 Avg True Vel North Average speed and average track True are the magnitude and direction of a velocity 
vector. Average True Velocity North and East are the north and east components of 
this vector. 

Scaling:  mm/sec (signed) 

170-182 81,82 Avg True Vel East 

183-195 83,84 Avg Mag Vel North Average speed and average track magnetic are the magnitude and direction of a ve-
locity vector. Average magnetic Velocity North and East are the north and east com-
ponents of this vector. 

Scaling:  mm/sec (signed) 

196-208 85,86 Avg Mag Vel East 

209-221 87,88 Speed MG North Speed Made Good and Direction Made Good are the magnitude and direction of a ve-
locity vector. Speed Made Good North and East are the north and east components of 
this vector. 

Scaling:  mm/sec (signed) 

222-234 89,90 Speed MG East 

235-247 91,92 Primary Flags Tells if valid data came from a primary or backup NMEA port. Each bit is a separate 
flag and has its own meaning. Bits are undefined if their data is invalid.  

If valid 1 = Primary, 0 = Backup. 

Bit 0  = Reserved 
Bit 1  = PSN 
↓ 
Bit 9  = ADCP Time Valid  
Bit 10 = Clock Offset Valid  
Bit 11 = Average True Vel North and East Valid 
Bit 12 = Average Magnetic Vel North and East Valid 
Bit 13 = Speed Made Good North and East Valid 
Bit 14 = Reserved 
Bit 15 = Reserved 

 

 

Bytes 79 through 92 were added in VmDas version 1.43. 

 



 

VmDas Software User’s Guide P/N 95A-6015-00 (January 2024) 

 

 
EAR99 Technology Subject to Restrictions Contained on the Cover Page. Page 121 

 

AP P E N D I X  A   

 
 

 

 

 

 

 

 

Appendix A 

APPENDIX 

 

 

In this chapter:  

• Turnkey mode 

• Disable a beam 
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Turnkey Mode 
When VmDas is started in the turnkey mode, a message box appears to prompt the user to start collecting 
data. After 30 seconds, or on confirmation, VmDas begins collecting data automatically.  

Syntax – “C:\program files\Teledyne RD Instruments\VmDas.exe” /autostart 

For example, if a computer operating system has VmDas with the /autostart switch in the startup folder, 
VmDas will open with a message box asking if it is OK to start collecting data when the computer is 
started. The user clicks OK or waits 30 seconds for the message box to time out. VmDas will close the 
message box, open a document in data collect mode, and begin collecting data. If the user clicks Cancel, 
VmDas exits. 

 

Figure 41. VmDas Shortcut in the Startup Folder 

 

Figure 42. Shortcut Properties 
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Figure 43. Autostart Dialog 

 

Turnkey mode only works on startup. Once data collection has started, VmDas reverts to 
normal operation. It will not enter turnkey mode again until closed and restarted with the 
/autostart switch. If a second document is opened with the File, Collect Data menu, the user 
must use the Control, Go menu item to start data collection. It will not happen automatically. 

 

Disable a Beam 
All ADCPs transmit signals into the water and receive the echoes backscattered from this transmission. 
Situations do arise, however, where very large backscattering (other than the normal scatters), can occur. 
Examples are structures, cables, other instruments, etc. In these situations, the user has to take care to 
make sure that these scatters do not interfere with the normal operation of the ADCP. In some cases, how-
ever, it may not be possible to avoid having objects blocking a beam. In this situation, the beam may be 
disabled. 

1. Exit VmDas.  

2. Open the C:\Users\yourname\AppData\Roaming\Teledyne RD Instruments\VmDas\VmDa-
sAutoConfig.ini file in NotePad® or a similar type of text editor. Do not use editors such as Word-
Pad® or word processors such as Word® or WordPerfect® because they add hidden characters to 
the file for formatting.  

3. Locate the [Expert only options] line (see Figure 44). 

4. Edit the TurnedoffBeam=0 line to TurnedoffBeam=x where x equals the beam number to 
turn off (1, 2, 3, or 4). Setting x to 0 enables all beams. 

5. Save the VmDasAutoConfig.ini file. 

 

Figure 44. Disable a Beam 
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NOTES 
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